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1 Introduction

1.1 Purpose of the Operating Guide

This guide provides basic knowledge required to use the VLT® Motion Control Tool MCT 10 with Danfoss drives. Familiarity with the

following is assumed:

l MS®-Windows™ at user level.

l Setup, process knowledge, and operation of the drive.

l Use of and linkage with communication equipment.

The operating guide does not provide any detailed information regarding specific applications or possible solutions and related

parameter combinations in the setup and use of a drive. Refer to the drive-related operating guide and design guide. Any update of the

guide and instructions related to MCT 10 is available at https://www.danfoss.com.

Familiarity with the PC or PLC master of the system is assumed. Issues regarding hardware or software produced by other manufacturers

are beyond the scope of this guide and are not the responsibility of Danfoss.

Refer to the appropriate guides for more information about master-to-master communication, or communication to a non Danfoss

follower.

1.2 Document and Software Version

This manual is regularly reviewed and updated. All suggestions for improvement are welcome.

Edition Remarks Software version

AQ283728700891, version 12

1.3 Intended Use

The VLT® Motion Control Tool MCT 10 enables full system configuration and control. With MCT 10, it is possible to monitor the entire

system more efficiently for faster diagnosis and better preventive maintenance.

Use cases of MCT 10:

l For planning a new communication network offline.

l For commissioning drives online.

l For easy replacement of drives.

l For easy expansion of networks with more drives.

l For backup of parameter settings of drives in a communication network.

l MCT 10 supports PROFIBUS DP-V1 communication via a master class 2 connection. This connection eliminates the need for an extra

communication network.

The communication framework part of MCT 10 is handling the control of the fieldbuses. It provides enhanced capabilities allowing

multiple concurrent fieldbus communications. Several fieldbuses can be configured and combined in the same network with MCT 10.

NOTE: If several fieldbuses are created with the same type, make sure that they are configured with different scan ranges.

Danfoss A/S © 2025.07                                                                                                                                                                        AQ283728700891en-001201 / 130R0466 | 11
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1.4 Software Modules

The VLT® Motion Control Tool MCT 10 software is supplied in 2 modules:

l MCT 10 software for:

¢ Setting the drive parameters.

¢ Copying parameter sets to and from the drive.

¢ Documentation/printout of setup, including diagrams.

¢ Servicing and fault analysis.

l APoss program for creating APoss programs.

1.5 Features of the VLT® Motion Control Tool MCT 10

l Project-oriented PC tool, 1 tool for all drive series.

l Links to all Windows™ applications possible.

l Supports Siemens CP PCMCIA- and PCI cards for PROFIBUS DP-V1 master class 2 connection.

l Supports standard interfaces: USB, RS485, Ethernet TSC.

l Siemens PG/Field PGs already have the required hardware.

l Downwards compatibility with Dos-Dialog (*.mnu) and WinDialog (*.vlt).

l Windows™ Explorer-like interface for quick and easy start-up and navigation.

e3
0b

t5
13

.1
3

PC (Master)

USB to RS485 converter

#1 #2 #3 #126

Figure 1: Connect up to 126 Nodes with a Repeater and up to 31 Nodes without a Repeater

1.6 Versions

VLT® Motion Control Tool MCT 10 is available in 2 versions. Go to https://suite.mydrive.danfoss.com/ for more information and for

downloading the program.
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1.7 Further Information

The following guides related to VLT® Motion Control Tool MCT 10 are available:

l VLT® PROFIBUS DP-V1 MCA 101 Installation Guide

l Drive-specific design guides

Refer to https://www.danfoss.com/en/about-danfoss/our-businesses/drives/ for more information.

It is also possible to find video training material on this site for operating the MCT 10.

Danfoss A/S © 2025.07                                                                                                                                                                        AQ283728700891en-001201 / 130R0466 | 13

https://www.danfoss.com/en/about-danfoss/our-businesses/drives/


2 Safety

2.1 Safety Symbols

The following symbols are used in Danfoss documentation.

  DANGER

Indicates a hazardous situation which, if not avoided, will result in death or serious injury.

  WARNING

Indicates a hazardous situation which, if not avoided, could result in death or serious injury.

  CAUTION

Indicates a hazardous situation which, if not avoided, could result in minor or moderate injury.

  NOTICE

Indicates information considered important, but not hazard-related (for example, messages relating to property damage).

The guide also includes ISO symbols for general warnings, warnings related to hot surfaces and burn hazard, high voltage and electric

shock, and referring to the instructions.

ISO warning symbol for general warnings

ISO warning symbol for hot surfaces and burn hazard

ISO warning symbol for high voltage and electric shock

ISO action symbol for referring to the instructions

2.2 Safety Precautions

  WARNING

HIGH VOLTAGE

Drives contain high voltage when connected to AC mains input, DC supply, load sharing, or permanent

motors. Failure to use qualified personnel to install, start up, and maintain the drive can result in death or

serious injury.

l Only qualified personnel must install, start up, and maintain the drive.

l Before performing any service or repair work, use an appropriate voltage measuring device to make sure

that there is no remaining voltage on the drive.
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  WARNING

UNINTENDED START

When the drive is connected to AC mains, DC supply, or load sharing, the motor may start at any time. The motor may start by

activation of an external switch, a fieldbus command, an input reference signal from the LCP or LOP, via remote operation using

MCT 10 Set-up software, or after a cleared fault condition. Unintended start during programming, service, or repair work can

result in death, serious injury, or property damage.

l Disconnect the drive from the mains.

l Press [Off/Reset] on the LCP before programming parameters.

l Ensure that the drive is fully wired and assembled when it is connected to AC mains, DC supply, or load sharing.

  WARNING

DISCHARGE TIME

The drive contains DC-link capacitors, which can remain charged even when the drive is not powered. High

voltage can be present even when the warning indicator lights are off.

Failure to wait the specified time after power has been removed before performing service or repair work

could result in death or serious injury.

l Stop the motor.

l Disconnect AC mains, permanent magnet type motors, and remote DC-link supplies, including battery

backups, UPS, and DC-link connections to other drives.

l Wait for the capacitors to discharge fully. The discharge time is specified on the drive nameplate.

l Measure the voltage level of the capacitors to verify that there is no voltage before opening the drive or

performing any work on the drive.
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3 Installing and Uninstalling

3.1 Introduction to Installation

The VLT® Motion Control Tool MCT 10 software and SyncPos modules are installed via a multilingual, self-explanatory installation

program.

3.2 Starting the Installation Program

1. Run MCT10_Vx.xx.msi.

2. Follow the instructions of the installation program.

Ü When the installation process is complete, the MCT 10 Set-up Software is found on the following path:

e3
0b

t5
14

.1
4

Figure 2: Path for the MCT 10 Set-up Software

3.3 Selecting the Software Language

The Danfoss default language is English. If another language is selected, it becomes the new default.

1. Select Options from the main menu, then select Select Language.

2. Select the wanted language from the scrollbar and click OK.

NOTE: Changing the language affects the parameter language. If an external LCP is connected to the drive,

the change of language version does not affect the language in the display.

3. Close and restart MCT 10 to activate the language setting.

3.4 Uninstalling the Software

NOTE: The following procedure is only valid for Windows™ operating systems.

1. Press Start.
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2. Select Settings.

3. Select Control Panel.

4. Double-click Remove/Add Programs.

5. Select Remove.
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4 Communication Setup

4.1 Communication Options

Drives in the VLT® HVAC Drive FC 102, VLT® AQUA Drive FC 202, VLT® Midi Drive FC 280, and VLT® AutomationDrive FC 302 series are

equipped with a USB port. Communication from a PC can be established using a standard A–B male-to-male USB cable connected to

the drive. No extra hardware or bus configuration is required. If the PC is equipped with more than 1 USB port, several drives can be

connected. The USB bus is automatically added to the network bus list.

Establish a hardwired connection through:

l Standard built-in RS485, or

l USB port.

The USB interface socket allows devices to be connected and disconnected using hot swapping. When connecting a drive using USB,

VLT® Motion Control Tool MCT 10 automatically adds it to the bus list.

If the Ethernet based option is mounted in the drive, for example, VLT® PROFINET MCA 120 or VLT® EtherNet/IP MCA 121, establish the

connection via Ethernet based network.

If the VLT® PROFIBUS DP-V1 MCA 101 option is mounted in the drive, establish the connection via PROFIBUS master class 2 connection

(MSAC 2)

NOTE: Connect soft starters either via a USB cable or via Ethernet.

  NOTICE

RISK OF DAMAGE TO PC USB HOST CONTROLLER

When connecting the PC to the drive through the USB cable, there is a risk of damaging the PC USB host controller.

l Follow the recommendations for grounding described in the operating guide for the relevant drive.

l Use a USB isolator with galvanic isolation to protect the PC USB host controller from ground potential differences when

connecting the PC to a drive through a USB cable.

l Do NOT use a PC power cable with a ground plug when the PC is connected to the drive through a USB cable.

Communication from a PC can be established via RS232 to RS485 converters or via USB to RS485 converters.

e3
0b

t6
31

.1
3

USB to RS485 converter

USB

RS485

#1 #2 #N

Figure 3: Communication from a PC
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4.2 Manual Fieldbus Configuration

After installation, configure the non-plug-and-play networks via the fieldbus configuration dialog.

1. Start the VLT® Motion Control Tool MCT 10.

2. Select Network.

3. Right-click Network and select Add/Remove/Configure Buses.

e3
0b

t6
22

.1
2

Figure 4: Refreshing the Fieldbus List

4. Add, remove, or configure the properties for the connected fieldbuses.

Ü 

e3
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Figure 5: Fieldbus Configuration

5. Scan the network for active drives to make MCT 10 indicate available drives on the non-plug-and-play fieldbuses.
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4.3 Scan

4.3.1 Automatic Scan

Only the USB fieldbus is scanned automatically when a drive is connected to the PC. For non-plug-and-play fieldbuses, scan manually for

active drives.

4.3.2 Scan Range Configuration

Enter the preferred scan setting by right-clicking on Serial bus and then selecting Configure Bus.

Adding a standard bus RS485 or PROFIBUS to the network tree configures the scan range to scan the entire address range. The Ethernet-

TSC bus is added using the current IP address settings.

The fieldbus scan range can be configured in several ways:

l Right-click the Fieldbus icon in the network tree and select Configure Bus.

l Mark the Fieldbus icon in the network tree and select Configure under Communication in the main menu bar.

l Open the Fieldbus Configuration dialog, right-click the Network icon, and select Add/Remove/Configure Buses.

l Open from the Windows™ panel.

e3
0b

t4
95
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4

Scan network icon

Figure 6: Scan Network Icon

4.3.3 Scan Network

Scan a fieldbus in 3 ways:

l Right-click the Fieldbus icon in the network tree and select Scan Bus for active drives.

l Mark the Fieldbus icon in the network tree and select Scan/Refresh under Communication in the main menu bar.

l Mark the Fieldbus icon in the network tree and select the Scan icon on the toolbar.

The Scanning for Drives window appears and indicates the progress of the scan.
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Figure 7: Progress of Network Scanning

4.4 RS485 Communication

4.4.1 Set Up the Drive with RS485 Data Communication

All drives can be configured to 9600 (default), 19200, 38400, 57600, or 115200 baud. The serial configuration is always configured with:

l 8 data bits.

l 1 stop bit.

l Even parity.

4.4.2 Configuring the Fieldbus

When using an RS485 converter as the Advantech ADAM converter, VLT® Motion Control Tool MCT 10 indicates online drives available on

the fieldbus after scanning.

NOTE: Protocol and advanced settings are for performance optimization and should normally not be changed.

1. Open the Serial Fieldbus Configuration dialog box or right-click the appropriate fieldbus.
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Figure 8: Serial Fieldbus Configuration

2. Set the COM port number.

When using USB to RS485 converters, the actual COM port number can be identified from the device manager part of the

Windows™ control panel.

3. Set the baud rate, parity, and the number of stop bits (must match the settings in the drive).

4. Set the fieldbus scanning range to the available address to limit the time scanning for active drives.

5. Press OK to activate settings or select to restore the default settings.

4.4.3 USB Data Communication

e3
0b

t6
23
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Figure 9: Network Bus List

When the USB cable is disconnected, the drive connected via the USB port is removed from the network bus list.
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4.5 MCT 10 with Soft Starters

4.5.1 Setup of Soft Starter

Setting up connectivity to the VLT® Soft Starter MCD 500 and VLT® Soft Starter MCD 600 requires that the USB communication module is

mounted on the soft starter. Communication from a PC can be established using a standard A–B male-to-male USB cable connected to

the USB communication module. If the PC is equipped with more than 1 USB port or a USB HUB, several soft starters can be connected.

4.5.2 Serial Configuration

All soft starters can be configured to 300, 1200, 4800, 9600 (default), 19200, 38400, 57600, or 115200 baud. The serial configuration is

always configured with:

l 8 data bits.

l 1 stop bit.

l No parity.
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Figure 10: Serial Configuration of Soft Starters

4.5.3 Configuring the Fieldbus

1. Add and configure the fieldbus from the Fieldbus Configuration dialog.

If the fieldbus is already added to the network, it can be reconfigured by right-clicking on the appropriate soft starter

fieldbus.

2. Set the COM port number. The actual COM port number can be identified from the device manager part of the control panel.

3. Set the baud rate, parity, and the number of stop bits (must match the setting in the soft starter).

4. Reset to Default restores the general settings and fieldbus scanning to factory configuration values.

4.5.4 Using the Hilscher NetIdent Protocol

Use the tool for searching for devices and for identifying and changing IP addresses. The tool also has a filtering function.

1. Click the Tools menu.
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2. Select Soft Starter Discover and Configuration Tool.
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Figure 11: Selecting the Hilscher NetIdent Protocol

3. Select the soft starter for which the IP address should be configured.

4. Click Configure.

4.5.5 Importing/Exporting Parameter Files, MCD 600

With the VLT® Soft Starter MCD 600, a parameter file, (PAR file) can be exported from the soft starter to a USB stick and copied into VLT®

Motion Control Tool MCT 10. After changing the file in MCT 10, the PAR file can be copied back to the USB stick and applied to the soft

starter.

1. Create an MCD 600 project soft starter.

2. Right-click the project folder.

3. Select Import Parameters.

4. From the dialog, select the file to import.

Ü A dialog opens and shows information about the selected file.
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If the soft starter differs from the project, it shows up as an error or warning in this view, depending on the difference.

5. Press Continue to apply the file.

Ü 

e3
0b

u3
11

.1
2

6. Click OK to close the window.

7. Right-click the project to export from MCT 10.

8. Select the parameters to export.

9. In the file selection dialog, select where to export the file to.

Ü A dialog appears when the export is complete.
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4.6 PROFIBUS DP-V1 Communication

4.6.1 Requirements

Setting up PROFIBUS DP-V1 communication requires a VLT® PROFIBUS DP-V1 MCA 101 option module. Communication from a PC using

PROFIBUS DP-V1 can be established using a PROFIBUS PCMCIA card or a card installed in the PC. The PROFIBUS cable from the drive is

connected to the 9-pin sub D socket connector on the card.
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PCMCIA
DP-V1 card

DP-V1

#1 #2 #N

DP-V1

#1 #2 #N

Insertable
DP-V1 card

Figure 12: PROFIBUS DP-V1 Communication

NOTE: Connectivity via PROFIBUS DP-V1 to a VLT® AutomationDrive FC 302 using the VLT® PROFIBUS Converter MCA 114

with option firmware version 2.03 is not possible via MCT 10. Use the fieldbus or USB bus instead.

4.6.2 Configuring PROFIBUS DP-V1

When using a PROFIBUS interface card with the associated driver installed, VLT® Motion Control Tool MCT 10 indicates online drives

available on the specific PROFIBUS after scanning the bus for active drives.

1. Configure the bus from the Fieldbus Configuration dialog or by right-clicking the appropriate PROFIBUS bus.
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Figure 13: PROFIBUS Fieldbus Configuration

2. Set the board number.

3. Set the fieldbus scanning range to the available addresses only to limit the time used for scanning active drives.

4. Click OK to activate or click Reset to default to restore factory settings.

4.6.3 DP-V1 Connection and PG/PC Interface

The VLT® Motion Control Tool MCT 10 PROFIBUS DP-V1 fieldbus plug-in uses the Siemens SoftNet driver available from Step7, or

alternatively Simatic NET, to establish connectivity via the supported master class 2 cards such as CP5511 or CP5512.

NOTE: STEP7 Lite version does not support the SoftNet driver.

4.6.4 Setting Up the PG/PC Interface

This procedure explains how to set up the PG/PC Interface from default configuration to open the PROFIBUS connection from VLT®

Motion Control Tool MCT 10. Cabling and terminations must be in accordance with wiring and cabling requirements for PROFIBUS.

1. Open the PG/PC Interface.
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Figure 14: Set PG/PC Interface

2. Configure Access Point of the Application to CP-L2_1 pointing to the master class 2 card used.

3. Set Interface Parameter Assignment Used corresponding to the master class 2 card used.

4. Select Properties to configure the station- and network parameters.

¢ Station parameters:

n Set PG/PC is the only master on the bus to Active if no PLC is active on the bus. Use the Diagnostics described later to

select a valid PROFIBUS address.

¢ Network parameters:

n Set the Transmission rate to the same baud rate as the PLC if it is active.

5. Select DP in Profile and click OK to close the Properties dialog.

6. Select Diagnostics in the Set PG/PC Interface to verify network- and bus communication.
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Figure 15: Properties Dialog
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Figure 16: Simatic Network Diagnostics Dialog

7. Select Test to verify the access path and network configuration. If a sharing violation is detected, the test results in an error

message. When the test result is successful, select Read to identify the active PROFIBUS nodes available on the network. Make

sure that the address defined for the PG/PC interface does not conflict with an active node.

8. Close the PG/PC interface and start MCT 10.

9. Right-click a PROFIBUS and select Scan for active drives. MCT 10 identifies the same node IDs, except PLCs.
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4.6.5 PROFIBUS Multitelegrams

With the Parameters allowed per telegram drop-down list, it is possible to configure the number of requests to be associated within a

multitelegram. The standard allows up to 40 telegrams to be associated.

The following options are available:

l Maximum speed (default configuration). Handles the association automatically and adapts the number of telegrams for each drive

according to the series. Can be used in PROFIBUS networks containing both old and new Danfoss drives.

l Conservative. Always associates 10 telegrams within a multitelegram. This option is useful when communicating only with old

products such as the VLT® Decentral Drives FCD 300, VLT® DriveMotor FCM 300, series derived from VLT® HVAC Drive FC 102, VLT®

AQUA Drive FC 202, and VLT® AutomationDrive FC 302.

l Single request. Only 1 request per telegram.

4.7 Ethernet-TSC Data Communication

4.7.1 Requirements for Ethernet-TSC Communication

To set up an Ethernet-TSC (transparent socket channel) communication, the VLT® EtherNet/IP MCA 121 option module is required within

the drive. Communication from a PC can be established using a standard Ethernet cable connected to the drive.

4.7.2 Ethernet-TSC Configuration

An Ethernet-TSC bus is scanned using DDP (drive discovery protocol). The protocol does not require an IP port number and IP scan range.

It identifies drives based on the MAC addresses.

NOTE: When scanning through different subnets or remotely via a VPN tunnel, it is advised not to utilize the ADDP

protocol but to use an IP range.

Click Refresh to generate a list of all active drives in the Ethernet. The list appears in the Ethernet Fieldbus Settings dialog when the scan is

complete.
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Figure 17: ADDP Configuration

Drive types without any IP configuration use their Auto IP Class B address, which is 169.254.yy.xx, with yy.xx corresponding to the last 2

segments in the MAC address. Several uncommissioned drives without any IP configuration can be scanned on the same network.

Select a device from the Discovered Drives list to;

l Get more information about the device.

l Assign a static IP address, a subnet mask, or default value to the drive.

l Set up DHCP (dynamic host configuration protocol) look-up.
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Figure 18: TSC Configure

4.7.3 PROFINET DCP Scan

e3
0b

m
57

1.
10

Figure 19: PROFINET DCP View
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4.7.4 Scanning with IP Range

When scanning using an IP range, the Ethernet telegrams are transmitted as traditional TCP/IP packages routed out in a router, switch,

or manage switch without requiring any changes. The disadvantage is an increased scanning time, and drives without IP address

configured are not identified.

NOTE: Identification of drives using the VLT® EtherNet/IP MCA 121 option is possible only from option firmware version

1.03 or newer. If using options with firmware versions earlier than 1.03, configure parameter 12-89 Transparent Socket

Channel Power to 0 to prevent the option from failing to operate.

1. Configure the IP start address and the transparent socket channel port (parameter 12-89 Transparent Socket Channel Port),

which is factory setting 4000 in the drive.
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Figure 20: Scan Range

Ü After the scan, all active drives are identified.

2. Use a corresponding drive to read or write to a single drive instead of waiting for MCT 10 to scan and identify all drives.

a. Open the project file and create offline drives manually.

b. Configure the connection properties.

c. Right-click the offline drive.

d. Read and write to the drive without scanning the bus.

4.7.5 Filtering

When using multicast, it is possible to filter a range of IP addresses.

Also, use filtering for boosting scan performance.
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Figure 21: Filtering

4.7.6 Wink Drive

During a commissioning process of a system containing several drives, it can be time-consuming physically to locate a drive based on

the VLT® Motion Control Tool MCT 10 project. This is especially the case if the drive is not equipped with an LCP.

Through the Ethernet_TSC fieldbus, it is possible via MCT 10 to use a wink function. This function blinks with the MS, NS1, and NS2 LEDs

on all Danfoss Ethernet-based fieldbus options.

On the Ethernet-based fieldbus option, the winking is recognized with all 3 LEDs blinking orange with 1-Hz interval. There is no limit to

the number of drives winking and the duration of winking.

4.7.7 Start Winking

NOTE: It can take up to 30 s from starting or stopping the winking, until the option responds.

1. Right-click a drive from the Ethernet network.

2. Select Start winking or Stop winking.
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Figure 22: Start Winking

4.7.8 Advanced

Use the Advanced tab:

l To configure Port Number For Range Scan. The default value is 4000.

l To define the TSC Connection Allocation/Sharing.

The drive has limited simultaneous connections, and with this function it is possible to define if the connections should be released or

not. If selecting Release Idling Connections, the VLT® Motion Control Tool MCT 10 releases unused connections and makes them available

to other users in the network after idle timeout.
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Figure 23: The Advanced Tab
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5 Parameter Setup

5.1 Introduction

This chapter explains how to control a drive using the VLT® Motion Control Tool MCT 10. After starting the MCT 10, the main window

looks like the example shown in Figure 24.
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Figure 24: MCT 10 Main Window

5.2 User Interface

5.2.1 Display

The VLT® Motion Control Tool MCT 10 has 2 views:

l Left view.

l Right view.

Left view

The left view shows the network view (real, online) and the project view (simulated, offline) of the drive network.

Use the left view to:

l Add or delete folders and elements.

l Store changes into the Project folder.

Store changes made to the real online set-up into the Project folder in the simulated, offline setup for later use.

For more information on saving data, refer to 6.12.2 Saving a Project.

The left view is organized in a tree structure and contents can be expanded or collapsed as required. Click +/- to expand/collapse the

folder.

Right view

The right view shows details of the element highlighted in the left view. In the right view, the elements of the drive network can be

programmed.
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Figure 25: Details Shown in the Right View

Toolbar

A toolbar shows icons for the most commonly used functions.
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Figure 26: Toolbar

Activate the toolbar under View in the main menu bar, where the toolbar is tick-marked when it is active. To deactivate the toolbar, select

View⇒Toolbar. Check that the toolbar is no longer tick-marked.

5.2.2 Network and Project Folders

The Network folder gives access to physical devices operating in the field. Use Network to configure the physical drive as with the LCP.

Configuration changes made in the Network folder are therefore saved only in the physical device in the field. The Network folder

contains online data.

The Project folder contains offline data.

NOTE: Changes made in the Network folder are not saved automatically to the Project folder.

Network mode - online

The Network folder contains the drives, low harmonic drives, active filters, and/or soft starters online connected to the PC. Monitor and

change the parameter settings exactly as if operating on the control panel.
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Data entered online is stored in the drive, low harmonic drive, active filter, or soft starter only, not on the hard disk. For information on

saving data to the hard disk, refer to 6.12.2 Saving a Project.

Project mode - offline

The Project folder contains the user-defined network of drive, low harmonic drive, active filter, and/or soft starter.

Data entered offline is stored on hard disk.

Use the Project folder to:

l Open a project file.

l Insert folders.

l Store project-related files in any format, for example, Word or PDF.

5.3 Setting Up Drives and Folders

5.3.1 Inserting a New Folder

1. Right-click the Project folder or select Insert in the main menu bar.

2. Select New.

3. Select Folder or File Folder.

5.3.2 Setting Up Drives, Active Filters, or Soft Starters

Insert the drive, the active filter, or the soft starter in a project folder as follows:

1. Right-click in the left view or click Insert in the main menu bar.

2. Select New.

3. Select the appropriate device type.

Ü Inserting a drive opens the New Drive window.
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Figure 27: New Drive Window

The New Drive window consists of 4 sections:

Name Enter a unique name for the drive. Any text/number
combination is allowed. Also specify the software version and
the voltage in this section.

Select Drive Type Information about the drive series and power size. A PUD file
(power unit data information) is also available. The default file
is always preselected.

Options Various information about the installed options.

Connection The fieldbus used between the PC and the drive associated
with the address to communicate. The specific fieldbus type is
available from the drop-down menu.

It is mandatory to fill in all fields. The different selections are available from the drop-down menus. Once the new drive is added to the

Project folder, the drive data is stored in the offline Project folder. To view the data, click the drive icon.
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Figure 28: View the Drive Data

To change the stored drive data, right-click the specific drive icon and select Properties.

5.3.3 Setting Up Low Harmonic Drives

Insert a low harmonic drive in a project folder as follows:

1. Right-click the left window or select Insert in the main menu bar.

2. Select New.

3. Select Drive.

4. Enter all relevant data in the New Drive dialog and click Make LHD.
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Figure 29: Entering Data for a New Low Harmonic Drive

NOTE: The Make LHD option is only available when the power size and voltage ranges of the drive correspond to

the supported low harmonic drive.

5. Enter all active filter data in the New Filter dialog. Ensure that the fieldbus address used for the active filter is not used for other

components.

Ü The low harmonic drive is visible in the project as a composition of the drive and the active filter.
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Figure 30: Low Harmonic Drive Shown in the Project Folder
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5.3.4 All Parameters Folders

A new Drive folder contains an All Parameters folder. This folder comprises a series of subfolders with generic names. There is no rename

function for these folders. The generic folders within most drives consist of the following subfolders:

l Operation and display.

l Load and motor.

l References and limits.

l Inputs and outputs.

l Special functions.

l Serial communication.

l Technical functions.

The generic folders can vary according to the type of drive selected.
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Figure 31: Subfolders in the All Parameters Folder

The generic folders comprise parameters relevant to the drive type selected.

5.3.5 Array Parameters

Parameters containing array data are shown as a matrix in the right view, where the rows of the matrix are defined as ID.1, ID.2, and so

on. For example, array parameters parameter 9-15 PCD Write Configuration and parameter 9-16 PCD Read Configuration are shown over

several entries as 915.1, 915.2, 915.3, and 916.1, 916.2, 916.3 in the right view.
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Figure 32: Array Parameters

5.3.6 Sorting

The Danfoss products listed under Network or Project can be sorted according to:

l Folder name.

l Series.

l Software version.

l Address (communication address).

l Power size.

l Voltage.

Click the sorting bar and select the relevant sorting option.
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Figure 33: Sorting Options
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5.4 Customizations

5.4.1 Customized Views

Select View in the main menu bar to see the display options. The following options are available:

l Show or hide the toolbar.

l Show or hide the status bar.

l Large icons/small icons view.

l View as list of folders and elements.

l View with details of network and project elements.
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Figure 34: The View Menu

5.4.2 Customize Parameter View Settings

Apply the selected parameter view settings to subfolders, to an entire project, or to the entire application, that is, all VLT® Motion Control

Tool MCT 10 folders in network or project mode.

1. Right-click the parameter cell or setup column.

2. Select Apply Parameter View Settings.
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Figure 35: Applying Parameter View Settings

3. Select the relevant option and click OK.
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5.4.3 Customize Background Color

To customize the background color of the views, go to Options⇒Online Parameter Grid Settings.
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Figure 36: Customizing Background Color

1. Select Restore Default to restore factory default background color for online environment.

2. Click […] to open a standard true color picker.

3. Select Add to Custom Colors for customizing colors for later usage.

5.4.4 Customize Parameter View

The parameters shown in the right view are presented in a series of columns, containing ID, parameter name, 4 setups, units, and factory

setup.

Select Parameter view⇒Set-up⇒Remove Menu.

NOTE: Changes made to the removed setup are still stored in VLT® Motion Control Tool MCT 10 and can be shown by

selecting Customize Columns.

1. Right-click a column.

2. Select Customize Columns.

3. In the left view of the Customize Columns dialog, select the field to be added or removed.
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Figure 37: Customize Columns Dialog

4. Click either Add or Remove.

5. Change the order of the fields in the right view by clicking Move Up or Move Down.

6. Right-click a column and select Apply Parameter View Settings.
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Figure 38: Apply Parameter View Settings

7. Select if the settings should apply to the subfolders, the entire project, or the entire application.

5.4.5 Filtering Parameters

Filter the parameters in the right view according to the following settings:

Table 1: Available Filter Settings

Setting Description

Read only Only read-only parameters are shown.

Read & Write Only read & write parameters are shown.

Changed parameters Only parameters that have been changed in the current session
are shown.

All All parameter groups are shown.

Group One or more parameter groups are shown according to selection.

1. Right-click any column in the right view.

2. Select the appropriate filtering setting or the appropriate filtering group.
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Figure 39: Filtering Columns
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5.4.6 Customize Columns

1. Right-click any column.

2. Select Customize Columns.
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Figure 40: Customize Columns Menu

3. Highlight a field to change the order.
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Figure 41: Change Order of Fields

4. Select Move Up, Move Down, or Remove.

Removed columns are still stored in the memory and can be retrieved into the right view by highlighting the relevant field

name and selecting Add.

5.5 Parameter Edit

The parameter structures in VLT® Motion Control Tool MCT 10 and in the drive are the same. Modify the parameter by double-clicking the

relevant parameter entry. If an entry cell is shaded, the parameter is read-only and cannot be modified.
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Shaded cells indicate read-only parameters

Figure 42: Editing Parameters

Change the parameter setup by manually entering new values in the cells in the right view. Alternatively, change the parameter setup by

importing values from an active drive using the Read From Drive function.

If a parameter value is set to an illegal value, an error is shown. Parameters can be edited in 2 different modes:

l Inline.

l Dialog-based.
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Figure 43: Edit Parameter View
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Inline edit

In inline edit mode, the available setting options are shown without any detailed descriptions of the options. Inline edit is only

recommended for experienced users.

Dialog-based edit

To have details of parameters available while editing, use dialog-based edit. The parameter details are:

l Parameter options.

l Ranges.

l Functions.

Enter dialog-based edit by deselecting inline edit.

5.6 Comparison of Parameters

Parameter settings can be compared to the parameter settings in another drive. Comparisons can be made either to another drive inside

the project or to an online drive. The comparison function evaluates whether settings inside the drive have been changed, or checks if 2

or more drives have the same settings.

Procedure

1. Activate the function by highlighting the base drive for comparison and select Compare.
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Figure 44: Comparison
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2. Select the drive to compare with.

This drive can be an online drive from the network, or it can be a drive in the offline folder (Project folder).

Ü The result of a comparison can be stored in an ASCII text file for documentation or for subsequent import into a spreadsheet.

It is possible to compare all setups, or to compare 1 setup to another.
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Figure 45: Comparison Result

5.7 Compare Multiple Drives

Comparing multiple drives is done via the menu. The project drive has to have the correct addresses. If necessary, the addresses can be

changed in the project properties by right-clicking the project and selecting Drive's Properties.
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Figure 46: Drive's Properties

Only drives from the same product series can be compared and written. If the series do not match, a status message is shown.
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Figure 47: Drive Series Mismatch

To start the comparison, right-click the project drive and select Compare Multiple Drives.
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Figure 48: Selecting Compare Multiple Drives

A window appears which shows the relevant drives being read.

e3
0b

u9
83

.1
0

Figure 49: Drives Being Read

When the read is complete, the comparison window appears.
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Figure 50: Comparison Window

The parameters in the red block are those which are set differently in the compared drives.

The parameters in the yellow block have not been compared.

The parameters in the green block have the same settings in the compared drives.

For common setup parameters, only setup 1 is compared. The result is shown as All Setups.

Exceptions

There are some parameters that, for technical reasons, are not written/compared. These parameters include some communication

parameters (8-31 Address, 9-18 Node Address, and 12-01 IP Address). Trying to write these parameters would cause loss of

communication.

Furthermore, safety parameters are not written.

5.8 View Change Log

When configuring a drive, active filter, or soft starter from the project, it is possible to view the change log containing the changes made

by the user only, or the changes made including the dependent parameters.

User-defined changes can be read out by right-clicking All Parameters and selecting Minimal Changeset.
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Figure 51: Minimal Changeset

Changes made including the dependent parameters can be read out by right-clicking All Parameters and selecting Compare parameters

with default values.
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Figure 52: Compare Parameters with Default Values

5.9 Read Drive Operation Status

The drive can be in 2 different operating conditions:

l Auto On

l Off

The operation status can be monitored via the LCP or VLT® Motion Control Tool MCT 10. Use MCT 10 to monitor the actual operation

status by clicking a drive in the network. Select Refresh Status to update the status information. Parameters can only be written to drives

in operation status Off.
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6 Operation

6.1 Reading and Writing Parameters

Parameter settings can be read from or written to an online connected drive.

Most parameters are read/write and can thus be configured. Other parameters are read-only and cannot be configured. Use the filter

function to view which parameters are read/write or read-only.

Select the values to be read/written and then select the Read From Drive or Write To Drive menu.

The following options are available:

l A single parameter in the right view.

l All parameters in the left view.

l A parameter group in the left view, for example, the Load and Motor group.

The read-from-drive and write-to-drive functions apply to the whole section.

Select Options in the menu bar to access a range of functions.
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Figure 53: Select Options

6.2 Read From Drive Settings

Select the required options for reading from an active drive.

Setups

Select to read visible setups only or to read all setups.
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Drive differences

If field device software and the MCT 10 software versions are not identical, specify the acceptable level of compatibility errors.

Select Allow drive differences to ignore all compatibility errors.

Select Allow drive version difference to restrict the acceptable compatibility errors to those occurring in different software versions but in

the same drive series. Select Do not allow drive differences not to accept differences between online devices and offline devices.

Save as default settings

Activate Read From Drive settings for all reads from the drive.
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Figure 54: Read from Drive Settings

6.3 Write to Drive Settings

Select the required options for writing to an active drive, which then becomes applicable for all writing to drives.
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Figure 55: Write to Drive Settings
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Write option

By default, Write All Parameters is selected. This means that all read and write parameters are written to online drives.

If selecting Write Changed Parameters, only the subset of parameters different from default is written. This selection improves

performance.

6.4 Communication Fault Tolerance

Set an acceptable number of communication faults before disconnecting. The default number of failures is 1000.
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Figure 56: Fault Tolerance

6.5 Connection Properties

To read or write between online and offline drives, configure the connection properties in the offline project. If the fieldbus does not

refer to an available drive in the network tree, VLT® Motion Control Tool MCT 10 is not able to identify the online drive.

Reconfigure the fieldbus by right-clicking the offline project and select Properties⇒Connection.

Configure the fieldbuses added to the network tree in the Fieldbus drop-down list.

6.6 Read From Drive

Values can be read from an active drive by right-clicking a selection and then selecting Read from drive.
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Figure 57: Read from Drive

Once Read from drive is selected, the software accesses the online device and shows the Drives Check window. This window contains a list

of drives with detected compatibility issues.
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Figure 58: Drives Check Window

Select Details to view details on the different properties between project device (based on database information) and online device (the

connected drive).
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Figure 59: Details

The color codes indicate the level of compatibility between the project drive and the connected drive for each property.

To continue the reading process, define an action in the Drives Check dialog. The default action is Continue. Other available selections are:

l Skip the drive.
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l None.

l Update project and continue.

The same action can be applied to all devices at a time instead of 1 by 1.

If selecting Skip the drive, VLT® Motion Control Tool MCT 10 does not read that particular device, but continues reading the other devices.

Continue resumes reading. Acknowledge and accept any differences found.

Update project and continue activates the read-from-drive process, and it deletes the data in the project drive and replaces it with data

from the connected drive.

NOTE: The Update from connected selection deletes and replaces all information stored in the project drive. To retain the

information entered into the project drive, select Continue.

Once the read-from-drive process is completed, the display shows details of both the Connected Drive Information and the Database

Information.
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Figure 60: Read-from-drive Process Completed

6.7 Changing the PROFINET Host Name

As of VLT® Motion Control Tool MCT 10 version 4.3, the domain name and host name can be changed via the Read-from-drive Process

Completed dialog.

Procedure

1. Click Change domain or host name.
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Ü A dialog for entering the domain name and host name opens.
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Ü The values entered in the dialog are written to parameter 12-07 Domain Name and parameter 12-08 Host Name.

6.8 Write to Drive

Procedure

1. Right-click a parameter column title in the right view or click Communication in the main menu bar.

2. Select Write to drive.
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Figure 61: Write to Drive

6.9 Write to Multiple Drives

Add addresses in the Address field and in the Secondary Addresses field. Secondary Addresses in the right view is enabled for DP-V1,

Ethernet, Serial, and Dummy.
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Figure 62: New Drive Dialog

Write parameter values to the main address and to secondary addresses. If the drive is not available on the configured address, it must be

skipped.

If a drive is configured with secondary addresses, the Write to Multiple Drives context menu is enabled on the right-view parameters, on

the parameter headers context menu on the left-view group, and on the drive menu.
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Figure 63: Examples, Write to Multiple Drives, Right-View Parameters
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Figure 64: Examples, Write to Multiple Drives, Parameter Headers Context Menu, and Drive Menu

6.10 Polling

6.10.1 The Polling Function

When in network mode, MCT 10 automatically polls the parameters in the right view to update their status continuously to reflect live

operation.

6.10.2 Stop Polling

To stop polling, for example, to freeze and analyze a particular moment:
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Procedure

1. Click Communication in the main menu bar.

2. Select Stop polling.

Alternatively, click the Stop polling icon in the toolbar.
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Figure 65: Stop Polling Icon

6.10.3 Resume Polling

Procedure

1. Click Communication in the main menu bar.

2. Click Resume polling.

Alternatively, click the Resume polling icon in the toolbar.
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Figure 66: Resume Polling Icon

6.10.4 Using Smart Polling (Intelligent Scan Frequency)

While VLT® Motion Control Tool MCT 10 is polling the parameter grid, the LCP becomes slow. To improve LCP usability, configure MCT 10

to enable smart polling. Enabling smart polling slows down the polling when the LCP is connected.

Procedure

1. Click Options in the main menu bar.

2. Select Online Parameter Grid Settings.
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Figure 67: Selecting Online Parameter Grid Settings

3. Tick the checkbox Enable Smart Polling (slow down the polling when the LCP is connected).
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Figure 68: Ticking the Checkbox

6.11 Changing the Setup of a Field Device

Procedure

1. Open the Network folder.

2. Select the relevant device.

3. Select Stop on the toolbar to stop polling.

4. Change the settings in the setup columns in the right view.
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Ü The changes are implemented online in the field device, but are not recorded.

6.12 Save Changes to a Hard Disk

6.12.1 Record Online Changes

Procedure

1. Select the relevant device in the Network folder.

2. Right-click the device and select Copy.

3. Select the Project folder.

4. Right-click and select Paste.

5. Select File from the main menu bar.

6. Select Save As.

7. Save the device file into a directory in the storage location.

6.12.2 Saving a Project

Procedure

1. Click File in the main menu bar.

2. Select Save.

Alternatively, click the Save icon in the toolbar.

6.12.3 Including Drive Information

It is not possible to open a project file including a firmware version not supported by VLT® Motion Control Tool MCT 10. Including the

drive information in the project file makes it possible to open in other installations with MCT 10 without having the firmware installed.

By opening the project file, the drive information is updated similarly to:

l Selecting Update Drive Support under Tools in the main menu bar.

l Downloading the drive information from an online drive.

The drive information is saved in the project file.

6.12.4 Exclude Drive Information

Procedure

1. Click Options in the main menu bar.

2. Select Project properties.

3. Click Include drive support in project.
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Figure 69: Save Drive Information

6.13 Import of Older Dialog Files

For users working with VLT set-up software dialog, the files generated with these software packages can be imported into the VLT®

Motion Control Tool MCT 10.

Files from DOS versions and Windows versions can be imported to the MCT 10 software. Following a successful import, the MCT 10

places the imported files in an imported files folder.
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Figure 70: Import Older Dialogs
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Due to limitations in some of the former PC tools, some functionalities cannot be imported, for example, functions such as showing

changed values only.

6.14 Printing

There are 2 print options in VLT® Motion Control Tool MCT 10:

l Print project.

l Print selected folders.

Both options are in the File menu in the main menu bar. Alternatively, right-click the Project icon and select Print project.

To print a folder, right-click a folder icon within the project and select Print selected folders.

Select Print project to print parameter settings for an entire project. Select Print selected folders to print parameter settings for part of a

project.

Figure 71: Print Options

Select the wanted print language from the drop-down list.
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Changed parameters

Print either parameters that have been changed from factory setting or all parameters.

Options

Select which setup to print.

More

Click More to be able to print selected parameter groups only.
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Figure 72: Example of Print Selection

6.15 Update Database Information

If the VLT® Motion Control Tool MCT 10 database information is outdated, updates are available either in https://

suite.mydrive.danfoss.com or, when this is not possible, by reading from the drive itself.

When the MCT 10 database for a drive is outdated, the drive icon is shown with a red line through it and the Database information fields

show the message Not supported.
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Figure 73: Drive not Supported

Update the database either by right-clicking the drive icon and selecting Download drive info, or by clicking Download drive info.
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Figure 74: Database Update

To start reading from the drive, select Yes.
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When reading from the drive is complete, the drive icon no longer has a red line through it, and the Database information shows settings

identical to the Connected drive information.

Also, the parameter settings are shown in capital letters.

6.16 Update Drives Firmware Support in MCT 10

The VLT® Motion Control Tool MCT 10 can be updated regardless of the firmware of the drive.

Download upgrades from the Danfoss website www.danfoss.com.
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Figure 75: Update the MCT 10 Software

NOTE: The update files can be installed without administrator rights in Microsoft operating systems.

6.17 Software Compatibility

The VLT® Motion Control Tool MCT 10 project files can open legacy version project files.

For project files older than version 3.17, use a separate conversion tool for opening these files.
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Figure 76: Select Conversion Tool
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Figure 77: Convert Old Files

When MCT 10 has been updated, project files saved with a newer firmware version can be opened and used. Refer to Figure 78 for an

example.
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Firmware 2.01
Firmware 2.03
Firmware 2.51

Upwards compatibility

Compatible

Compatible

Updates:
Firmware 2.03
Firmware 2.51

Save
Save as

MCT10 Set-up software
Version 5.20

MCT10 Set-up software
Version 6.00

Support also:
Firmware 2.03
Firmware 2.51

Save

Firmware 2.01

Supports
Firmware 2.01

Figure 78: Use Updated MCT Software

6.18 Actual Software Version

Open the About box to see the actual software version of VLT® Motion Control Tool MCT 10

NOTE: System information can be copied directly to the Windows clipboard.
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Figure 79: Copy System Information

6.19 Conversion Wizard

6.19.1 Conversion

It is required that database versions, power size, voltage range, and option configuration of the source match the destination drive.

Differences can be converted using 1 of the conversion wizards available in VLT® Motion Control Tool MCT 10:

l VLT to FC series conversion.
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l FC series to FC series conversion.

NOTE: If the parameter database of a source drive is different from the database on the destination drive, it cannot be

written without errors signaled during write to drive.

6.19.2 VLT to FC Series

6.19.2.1 VLT to FC Series Converter Function

It is possible to convert, for example, a VLT® 5000 drive to a VLT® AutomationDrive FC 302 via the conversion matrix VLT® Motion Control

Tool MCT 10.

Read conversion

Excel sheet templateMCT 10
Set-up Software

Read settings

VLT 5000 FC 302
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Write settings

Figure 80: Conversion

6.19.2.2 Converting Multiple Drives

Procedure

1. Select the Tools menu and activate Drive Conversion Wizard.

2. In the subsequent dialogs, select the drives for conversion.

Ü When converted, a new VLT® AutomationDrive FC 302 drive is created in the Project folder.
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Figure 81: Conversion of Multiple Drives

6.19.2.3 Import Drive from Excel

Use this function to create a VLT® AutomationDrive project based on an Excel sheet. For example, import of VLT® 3000 settings from an

Excel sheet into a new FC 302.

An example file is attached in VLT® Motion Control Tool MCT 10 (vlt3000conversion.xls). This example file can be edited and used for

converting from VLT® 3000 to FC 302.

NOTE: Detailed knowledge of Microsoft Excel formula editing is required.

6.19.3 FC Series to FC Series Conversion

1. Right-click the drive to be converted.

2. Select Convert Drive... from the context menu.
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Figure 82: Convert Drive

3. Select the target drive.

4. Add a name to the drive in the field Drive Name.
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Figure 83: Assign Name to Drive
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7 Diagnostics

7.1 Alarm, Warning, and Fault Log Readout

Features from version 2.0 support:

l Reading out alarms, warnings, and fault logs of the online drives.

l Quick location of alarms and warnings in the connected drive system.

l Investigation of the fault log for previous trips.

l Gathering and storing events in the project file for later evaluation.

l Sending the project file to a remote specialist for further investigation.

7.2 Localization of Alarms and Warnings

After a complete scanning of a drive network, VLT® Motion Control Tool MCT 10 indicates if the connected drives have active warnings

and alarms. An exclamation mark in front of the drive icon indicates a warning or an alarm.
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Figure 84: Drive with Active Alarm or Warning

Expand the drive and click the alarm/warning icon.

Name Icon

Active alarms/warnings
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Figure 85: Fault Log View for Control Cards Marked MKI
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Figure 86: Fault Log View for Control Cards Marked MKII

For a more detailed description of the code, refer to the operating guide for the particular drive. If the drive trips, it stores the cause for

the trip in a fault log buffer. The log consists of 3 values:

l Code.

l Value.

l Time.

When MCT 10 reads the fault log, it shows the time and date when the log was read.

NOTE: The actual time when a fault occurs is not indicated.

7.3 Storing Alarms/Warnings in Project Files

Alarms/warnings and the fault loggings are stored into the Project file. VLT® Motion Control Tool MCT 10 automatically reads alarms,

warnings, and fault loggings at every read from/write to the drive.

7.4 Handling the Alarms and Warnings Loggings

VLT® Motion Control Tool MCT 10 allows more than 200 alarms and warnings for each drive in the project. The loggings can be cleared

individually. This is done by entering the loggings to clear and then right-clicking. Clearing the log only clears the PC log while the

information in the drive is unaffected by this handling.

NOTE: There are redundant alarm entries in the log.

MCT 10 stores active alarms and warnings in the Project file at each read/write command. No alarm is lost, but an alarm can have

multiple entries in the log.

e3
0b

t5
49

.1
3

Figure 87: Loggings
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7.5 Scope

7.5.1 The Scope Function

The scope function supports monitoring and diagnosing of parameters. The function polls parameter data and dynamically shows the

polled data as a curve graph.

The scope function provides 2 different channel types to sample parameters:

l PC polling channel - Channel selected when the PC SW requests the parameters from the drive. The channel does not have any time

limitation, the buffer size is user-configurable and corresponds to the number of samples. Fast sampling with an accurate sampling

rate cannot be obtained because the Windows operating system does not support real-time extension.

l Drive real-time channel - Only available in the FC 102, FC 202, and FC 300 series - uses an internal 16-kByte buffer in the drive.

Recommended for continuously monitored applications requiring high and precise sampling rates. It is required to set up a trigger

event for the drive to start filling up the buffer with samples.

7.5.2 Activating the Scope

Insert a new scope from the Insert menu or by right-clicking the Project folder, Drive folder, Regular folder, or Drive.
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Figure 88: New Scope

Rename the Scope folder via the Edit menu or by right-clicking the icon and select Rename.

The 1st time that the Scope folder is selected, the Add Channel dialog pops up. From this dialog, select the drive to monitor. Then,

depending on the drive series, select the type of channel to collect samples from.
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Figure 89: Add Channel

Adding text notes

Insert additional text for later usage to each scope folder such as the type of drive monitored and diagnostic help text. Text notes are

added by right-clicking the Scope folder and selecting New⇒Text note. The default text can be changed by right-clicking the text note

and selecting Rename. Several text notes can be added to the same Scope folder.
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Figure 90: Text Notes

7.5.3 Configuring the PC Polling Channel

PC polling channel is enabled by default when a drive is selected within the Network folder or Project folder. All parameters available in

the list are visible by ID name and are automatically updated according to the product.
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Figure 91: Parameter ID and Name

Procedure

1. Select a parameter in the parameter list and click Next to update the Add Channel dialog.

2. Configure A/div (value/division).

NOTE: VLT® Motion Control Tool MCT 10 stores the values even if they are not shown within the visible area

of the curve.
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Figure 92: Storing Values

3. Define the position number (vertical zero line on the Y axis). If there are several signals on top of each other, it is useful to have

them plotted apart.

4. Set color and tick Marker to differentiate the different curves in a black and white printout. Each curve gets a marker as box,

triangle, cross, and so on.

5. Click OK to generate the curve graph.
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Figure 93: Generate Curve Graph

6. Right-click the channel box to open the Add Channel dialog and add extra channels.
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Figure 94: Open Add Channel Dialog

7.5.4 PC Polling Channel Properties

More settings can be configured by right-clicking the Scope window and selecting Properties. It is possible to specify:

l General parameter sample settings.

l Sample trigger settings.
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l Cursor settings.

General parameter sample settings

The General tab holds 4 basic settings for the Scope Properties:

l Seconds per division (SEC/DIV).

l Time format.

l Buffer size in samples.

l Polling rate in milliseconds.
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Figure 95: Basic Scope Settings

Table 2: Format and Range of the Basic Scope Settings

Description Format Value range

SEC/DIV Time base on the X-axis 0.0001–1.000.000.000 s

Time format Year, month, date, hour, seconds, and mil-
liseconds

–

Buffer size Number of data sets in the buffer 0–1.000.000

Polling rate Time in milliseconds between 2 samples –

NOTE: For systems with large inertia, a low sampling rate may be used since the value changes slowly. For systems with

low inertia, a high sampling rate is needed.

NOTE: Setting Polling Rate to As fast as possible means that VLT® Motion Control Tool MCT 10 does not control the actual

time between each sample. This can lead to a high jitter between 2 samples.

Trigger

The trigger function starts the sampling of values only when a certain value is reached. This reduces the need for large buffer sizes. A

trigger is also a valuable tool to see if values cross borders where the drive does not store any warnings.
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Figure 96: Trigger Functions

Table 3: Descriptions of the Trigger Functions

Trigger functions Description

Source Source channel.

Level Level where the trigger has to be activated.

Mode Auto starts the trigger automatically when Resume All is pressed.
The trigger line is set to the time when Resume was pressed. Nor-
mal (Norm) activates the trigger when level and slope settings are
fulfilled.

Slope Sets if the value must rise (source value goes from low values to
high values) or the slope must fall (source value goes from high
values to low values).

Cursor

Style defines the functionality of the cursor. The style contains 5 different possibilities:

l Value XY - Shows the time and value of each signal at the cursor location.

l Value X - Shows the time only.

l Value Y - Shows the value only.

l Delta X - Shows 2 cursors, and the time between the 2 cursors is calculated.

l Delta Y - Works like Delta X, but this time the difference between the 2 levels is calculated.
The pointer position defines the default position when a cursor is inserted in Scope.

Cursor
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.1
0 Inserts cursor in scope

7.5.5 Reuse of PC Polling Channel Settings

Often, the same settings are used when measuring with the PC polling channel on more than 1 drive. These settings can be reused either

by copying an existing scope folder or by reusing an existing one.
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Reconfigure the scope folder connection properties for another drive in the network by double-clicking an added channel. In the

Reconfigure Channel dialog, another drive on the same or a different fieldbus can be selected.
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Figure 97: Reconfigure Channel

7.5.6 Configuring the Drive Real-time Channel

Drive real-time channel can be selected if the selected drive supports this functionality.

Procedure

1. Select the relevant drive.

Ü Drive Real-time Channel opens the Scope Properties dialog.

2. Configure the channels depending on what the actual drive supports.
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Figure 98: Select Drive Real-time Channel

All available parameters are listed by parameter name.

3. Configure the sample rate for each channel using the time format HH:MM:SS:zzz.

4. Configure the sampling mode through:

– The trigger event.

– Logging mode.

– Samples before trigger options.
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Figure 99: Configure Sampling Mode

7.5.7 Using Advanced Triggers

The following example explains the setup of a trigger, which triggers the collection of data in the drive when the motor speed exceeds a

certain limit.

Set up a comparator in the smart logic control to get a trigger signal when the motor speed exceeds a certain limit:

Procedure

1. Select the smart logic group.

2. Select a comparator not in use, 1310.0, and set it up to motor speed.

3. Set Comparator Operator 13.11.0 greater than >.
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Figure 100: Smart Logic View

4. Set Comparator Value 1312.0 to the required value.

5. Set up the trigger event in the Drive Real-time Channel Properties dialog to comparator 0.

6. Set the logging mode to log once on trigger.

7. Press OK to enable the setup.
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Figure 101: Trigger Event

8. Press Start (resume) poll to start logging.

Ü The dialog for defining the real-time log style opens.
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Figure 102: Real-time Log Style

7.5.8 Drive Real-time Channel Properties

More settings can be configured by right-clicking the Scope window and selecting Properties.

It is possible to reconfigure all drive real-time channel settings and also to configure:

l SEC/DIV and time format.

l Appearance settings.

l Cursor settings.
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Figure 103: Reconfigure Drive Real-time Channel Settings

Besides being able to reconfigure the settings made from the Drive Real-time Channel Properties dialog, SEC/DIV and the time format are

configurable.
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SEC/DIV

The SEC/DIV and Time format functionalities are similar to the PC polling channel functionality, see 7.5.3 Configuring the PC Polling

Channel.

Appearance

Each channel name can be renamed.

The Units/Div, Position, Marker, and Color functionalities are similar to the PC polling channel functionality.

Cursor

The functionality is similar to the PC polling channel functionality.

7.5.9 Communication Control

The Scope toolbar has 4 main buttons for communication control.

Table 4: Functions of the Control Buttons

Control button Function

Start Data Acquisition
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.1
2 MCT 10 scope starts collecting the re-

quested data from the drive network.

Stop Data Acquisition
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.1
2 MCT 10 stops collecting data and there is

no communication to the drive network
while the scope part is active on the screen.

Resume All (Tracking)

e3
0b

t5
62

.1
2 Activates the tracking mechanism. MCT 10

starts the readout of variables to the screen
and to the buffer. Variables are checked
against the trigger settings. If the buffer has
been partially filled (use of the Pause All
Tracking function), MCT 10 continues to fill
data into the buffer.

Pause All (Tracking)
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.1
0 Deactivates the tracking. The buffer re-

mains at its current state, no new data is
shown. The buffer pointer keeps its current
position.

7.5.10 Additional Functionality

Select Resume poll to start tracking. To stop tracking, click Stop poll or Pause all tracking. The tracking continues until the buffer is filled

(default 1000 samples). If the tracking stops due to a filled buffer, the buffer has to be emptied before a new track can be activated. Clear

the buffer and reset the scope in 1 step by clicking the icon shown in Figure 104.

Figure 104: Clear all Buffer for the Channel

Alternatively, the buffer can be cleared individually.
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Figure 105: Individually Clearing the Buffer

Table 5: Functions of the Main Buttons

Name Description

Reset Scope
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.1
2 Clears all buffers for the channel at once.

This is more convenient if many channels
are activated at the same time, or if a new
channel is added to an existing track. Be-
fore new values can be added to a track,
all channel buffers must be emptied, since
MCT 10 requires that all buffers have the
same amount of data.

Export to Excel
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.1
2 Enables storing scope data in a file which

Microsoft Excel can open. A Save file dialog
appears, making it possible to store the file
in an appropriate location.

Scope Storage
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1 Enables storing scope data in a file on the

hard disk. Save to the hard disk to avoid the
limitation of 1 million points in the project
file.

Open Scope History Viewer
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1 Open scope data saved on the hard disk.

7.5.11 Scope Storage

Enable scope storage or persistent data storage in Scope Properties. In Scope Properties, it is also possible to change and select where data

should be saved.
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Figure 106: Scope Properties

If polling data in scope when scope storage is selected, data is saved in both the project file and on the hard disk. However, the project

file is limited to 1 million points. When the limit is exceeded, VLT® Motion Control Tool MCT 10 replaces the oldest point with the latest

point.

7.6 Export Log Files

All log files can be exported to the desktop in 1 compressed .zip file.

Procedure

1. Select Help⇒About.
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2. Click Export log files.
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Ü All logs are compressed into a .zip file.
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8 Plug-ins

8.1 Smart Logic Controller Plug-in

From version 2.13, VLT® Motion Control Tool MCT 10 supports the smart logic controller plug-in. This feature enables quick setup of

logical sequence programs.

The smart logic controller monitors a predetermined event. When the specified event occurs, it performs a predetermined act and starts

monitoring the next predetermined event. The smart logic controller continues like this in up to 20 different steps until it returns to step

1 – monitoring the 1st specified event.

The smart logic controller can monitor any parameter that can be characterized as true or false. This includes digital commands and

logic expressions, which allow sensor outputs to determine the operation. Temperature, pressure, flow, time, load, frequency, voltage,

and other parameters combined with the operators >, <, =, AND, and OR form logic expressions that control the drive logically in any

application.

The smart logic controller supports multiple controllers. The basic functionality is the same, but the appearance differs slightly due to

multiple controllers being available in different tabs.

Refer to the relevant design guide for a full overview of the smart logic controller features.

8.2 Time-based Actions and Preventive Maintenance Plug-ins

8.2.1 Overview of Time-based Actions and Preventive Maintenance Plug-ins

For the VLT® HVAC Drive FC 102, VLT® AQUA Drive FC 202, and VLT® AutomationDrive FC 301/FC 302, the VLT® Motion Control Tool MCT

10 provides the following plug-ins:

l Clock features.

l Preventive maintenance.

l Time-based actions.

NOTE: Consult the product-specific design guide for detailed information about the drive.

8.2.2 Features of Time-based Actions

8.2.2.1 Clock Functions

The VLT® Motion Control Tool MCT 10 enables setup of the clock functions.

The clock functions are grouped in 2 sublevels:

l Date and time.

l Working days.

8.2.2.2 Date and Time

In the Date and time dialog, the following groups of settings are available:

l Display format.

l Set date and time.
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l Daylight saving time.

l Enable clock fault.

Display format in LCP

Select how date and time are presented in the LCP on the drive. In VLT® Motion Control Tool MCT 10 parameters, date and time format

depends on PC regional options (date and time format).

Set date and time

Change the date and time in the drive from the PC. Normally, it should be set to use the date and time of the connected PC. When the

time of the connected PC is in another time zone, it is beneficial to set the date and time manually. Date and time are changed in the

VLT® Motion Control Tool MCT 10 project file or in the drive only when the Change checkbox is ticked.

Daylight saving time

Set the date and time for daylight saving.

Daylight saving time begins for most of the United States at 2:00 a.m. on the first Sunday of April. Time reverts to standard time at 2:00

a.m. on the last Sunday of October. In the U.S., each time zone switches at a different time. In the European Union, summer time begins

and ends at 1:00 a.m. Universal Time (Greenwich Mean Time). It begins the last Sunday in March and ends the last Sunday in October. In

the EU, all time zones change at the same moment.

Enable clock fault

If the clock is not set up, the drive shows a specific warning. Enable or disable the clock fault function.

8.2.2.3 Defining Working Days

NOTE: Additional working days and non-working days include the year and must be updated every year.

Procedure

1. Select First day of the week (Monday or Sunday).

2. Select working days and non-working days.

3. Set additional working days (maximum 5).

4. Set additional non-working days (maximum 15).
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Figure 107: Define Working Days

8.2.3 Preventive Maintenance

The preventive maintenance feature supports the planning of periodic maintenance of both the drive and other technical equipment. If

the defined date and time of preventive maintenance is passed, the item is marked red.
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Figure 108: Preventive Maintenance

NOTE: Program the clock parameters (parameters in the Clock functions folder) for preventive maintenance to function

correctly.

Procedure

1. Double-click the cells in the right view to specify application item, action, and interval.

2. Reset Maintenance Word (in parameter 23-15 Reset Maintenance Word) and write to the drive.

8.2.4 Timed Actions

The time-based actions function enables automation of real-time controlled events.

Actions, which can be programmed, are the same as known from the SLC (smart logic controller), see 8.1 Smart Logic Controller Plug-in.

NOTE: The clock parameters (parameters in the Clock functions folder) must be correctly programmed for timed actions

to function correctly.
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Figure 109: Time-based Actions

Procedure

1. Select Timed Actions in the product folder.

2. Double-click the cells in the right view to specify:

– Action.

– Time.

– Recurrence.
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8.3 Motor Plug-in

8.3.1 Induction Motors
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Figure 110: Example of Settings for an Induction Motor

8.3.2 PM Non-salient SPM

For permanent magnet motors, calculation buttons are available. Below is an example of how to set parameter 1-25 Motor Nominal

Speed.
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Figure 111: Example of Settings for a Non-salient SPM Motor

Procedure

1. Enter the frequency and the number of pole pairs.

Figure 112: Enter Data for Nominal Speed
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2. Click OK to get the value.

Ü When the value is calculated, a notification appears. If the value is out of range, an error message appears and the

value reverts to the previous value.
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Figure 113: Notification Stating that the Value has Changed
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Figure 114: Error Message when the Value is out of Range

Changing the number of pole pairs in parameter 1-25 Motor Nominal Speed also changes the value of parameter 1-39

Motor Poles.
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Figure 115: Changing Number of Pole Pairs Affects 2 Parameters

8.3.3 PM Salient IPM

Same functions and behavior as PM, non-salient SPM.
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Figure 116: Examples of Settings for a Non-salient IPM Motor
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8.3.4 SynRM
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Figure 117: Examples of Settings for a SynRM Motor

8.4 Multi-motor Plug-in

8.4.1 Overview of Multi-motor Plug-in

In applications where 1 drive controls multiple motors/fans, a motor or motor/fan coupling failure may pass unnoticed due to missing

feedback from the controlled fan. One or a few motor failures may be less critical during low or normal operating load, but it can lead

to a full stop of the system in high-load situations. The multi-motor plug-in monitors and diagnoses the fan/motor state. The plug-in is

limited to 8 motors of equal size and type. The multi-motor calculation tool is only for variable torque applications.

Find the multi-motor plug-in in the drive folder on the left side of the screen. Use the plug-in either online directly connected to a drive

or offline for download later. Find the relevant parameters in parameter group 24-9* Application Functions 2.

NOTE: The multi-motor plug-in does not work on motors connected in parallel.

To get the right values, measure the current throughout the whole frequency band (from 0 Hz to maximum), also below the normal

operating points.

Failures or underload of motors issue a missing motor warning. The drive continuously checks if the total motor current is below the

expected value, which indicates situations where:

l One or more motors are missing/disconnected.

Danfoss A/S © 2025.07                                                                                                                                                                     AQ283728700891en-001201 / 130R0466 | 105



l One or more fans are loose.

Overload of motors issues a locked rotor warning. The drive continuously checks if the total motor current is above the expected value,

which indicates situations where:

l A rotor is locked.

l A fan touches the enclosure.

NOTE: During start-up or dynamic events like changes in speed references, the current may be below/above the current

threshold. Consider and evaluate whether such situations may occur.

8.4.2 Defining a Normal Operation Curve

The plug-in provides an easy way to find the coefficients of the 3rd order polynomial by measuring currents on different frequencies.

NOTE: To avoid wrong logical minimum in the 3rd order polynomial, enter the lowest possible frequency into the tool.

NOTE: Points can be inserted at any frequency, but the defaults are recommended as the points are not saved. Only

calculated coefficients are saved and used to recalculate the points on default frequencies after closing and opening the

view.

Procedure

1. Measure normal operation currents on 5 different frequencies.

2. Insert the frequencies in Normal operation currents.
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Figure 118: Normal Operation Currents

8.4.3 Threshold

Measured points show normal operation curves. Settings in Motor Data define the threshold of the upper and lower limits.
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Figure 119: Threshold

l Number of motors is a convenience value to reduce the tolerance bandwidth, dividing it by the number of motors used (maximum 8

motors).

l Tolerance defines the bandwidth as a percentage of the highest measured current.

NOTE: These settings are not saved and are recalculated after closing and opening the view. If the values are different

after recalculation, they still define the same tolerance. Example: 4 motors with 20% tolerance produce the same

bandwidth as 2 motors with 10% tolerance.

8.4.4 Coefficients

Locked Rotor Detection and Missing Motor Detection show parameter values exactly as they are written to the drive. The values are

synchronized automatically.
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Figure 120: Locked Rotor Detection and Missing Motor Detection

NOTE: Cubic and quadratic coefficients are multiplied by 1000 to overcome precision limitation of parameters.

8.4.5 Modified Curves

Changing the frequency of a measured point moves the point along the defined curve. As the point follows the previously defined curve,

the change of frequency only causes a slight change to the curve.
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8.5 Cascade Controller Plug-in

8.5.1 Overview of Cascade Controller Plug-in

The cascade controller is intended for pump applications where multiple motors control a common flow, level, or pressure. By varying

the speed of the motors, variable speed control is provided for the system. This maintains constant pressure while eliminating pressure

surges, resulting in reduced system stress and quieter operation.

Three versions of cascade controllers are available:

l Basic cascade controller

¢ Delivered as part of the software in the VLT® HVAC Drive FC 102 and VLT® AQUA Drive FC 202. The 2 relays on the power card

control the speed of a device connected to the drive output and on/off control devices.

l Extended cascade controller

¢ Allows more devices to be applied to the control circuitry and offers more cascade principles. It is available only in the FC 202

with a VLT® Extended Cascade Controller MCO 101 option card installed.

l Advanced cascade controller

¢ Offers the cascade principles similar to extended cascade, but allows extra devices to be applied to the control circuitry. It is

available only in the FC 202 by using the VLT® Advanced Cascade Controller MCO 102 option card.

The add-on option cards MCO 101 and MCO 102 can be used with the basic cascade controller (parameter group 25- ** Cascade

Controller) and with the extended/advanced cascade controller (parameter group 27-** Cascade CTL Option).

The cascade controller can be configured in VLT® Motion Control Tool MCT 10 from the cascade controller plug-in. Basic mode supports

the basic cascade controller, and extended mode supports the extended/advanced cascade options MCO 101/MCO 102.

The MCT 10 Cascade Controller view is divided into 4 tabs in both cascade modes:

l Preconditions.

l Setup.

l System Optimizing.

l Service.

8.5.2 Tabs in the Cascade Controller Plug-in

8.5.2.1 The Preconditions Tab

The Preconditions tab contains the general setup required for the cascade controller to operate in an application. It can also be used in

general to set up the closed loop for other applications without the need for the cascade control. Use Preconditions to configure:

l General configuration.

l Setpoint and feedback.

l Digital input.
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Figure 121: Preconditions

8.5.2.1.1 Areas in the Preconditions Tab

General Configuration

Closed loop is the configuration mode of the drive. Enabling or disabling the checkbox changes parameter 1-00 Configuration Mode.

Table 6: Closed-loop Checkbox Options

Options Parameter 1-00 Configuration Mode

Enabled [1] Closed loop

Disabled [0] Speed open loop

Level control configures the inverse mode of the PID controller. It causes the drive output frequency to increase when the feedback is

greater than the setpoint reference. If the checkbox is disabled, the PID is configured to normal control. Digital I/O mode and DI 32 are

enabled.
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Figure 122: Level Control

Enabling the checkbox configures the PID to inverse control, and digital I/O mode and DI 32 are disabled. The drive graphic is updated to

reflect the general configuration.
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Figure 123: General Configuration

The setpoint is used in closed loop as the reference to compare the feedback values. It can be offset with the digital, analog, or bus

references. Enabling the internal setpoint allows for entering a numerical value for the reference source. If the external setpoint is

selected, the reference source is set to AI53. The internal setpoint settings remain in the field allowing to switch between a preset- or an

external setpoint.

Setpoint and feedback unit type configures the pressure unit for the closed-loop setpoint and feedback. The pressure unit can be

defined in:

l %.

l mbar.

l bar.

l Pa.

l kPa.

l m WG.

l psi.

l lb/in2.

l in WG.

l ft WG.
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General configuration affected parameters

l Parameter 1-00 Configuration Mode.

l Parameter 20-81 PID Normal/Inverse Control.

l Parameter 3-15 Reference 1 Source.

l Parameter 20-12 Reference/Feedback Unit.

Setpoint and Feedback

Configure the analog input used as setpoint and feedback. The general configuration assumes the AI 53 (analog input 53) is used for the

setpoint and the AI 54 (analog input 54) is used as feedback. The signal type can only be changed from current to voltage input with the

switches on the control board of the drive. Click Show location to see the specific location on the drive.
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Figure 124: AI53 and AI54

Configure the signal type in accordance with the hardware switches.
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Push the switch to the left to get a 0–10 V signal type. Push the switch to the right to get a 0–20/4–20 mA signal type.

Setpoint high and Feedback high configure the analog input scaling value corresponding to the maximum reference feedback value.

Setpoint low and Feedback low are used to configure the analog input scaling value corresponding to the minimum reference feedback

value. The minimum and maximum references are the lowest and highest values obtainable by adding all references together.
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To receive notification of a missing or defective transmitter, define live zero among the functions:

l Off.

l Freeze output.

l Stop.

l Jogging.

l Maximum speed.

l Stop and trip.

l Select setup 1.

l Select setup 2.

l Select setup 3.

l Select setup 4.

The function is activated if the signal on terminal AI 53 or AI 54 is below 50% of the value defined in AI 53 low or AI 54 low. Default Live

Zero Timeout time is 10 s and can be reconfigured in parameter 6-00 Live Zero Timeout Time.

Enable Terminal 53 live zero and Terminal 54 live zero to disable the live zero monitoring if the analog outputs are used as part of a

decentral I/O system. As default, both checkboxes are enabled.

Setpoint and feedback affected parameters

l Parameter 3-02 Minimum Reference.

l Parameter 3-03 Maximum Reference.

l Parameter 6-01 Live Zero Timeout Function.

l Parameter 6-10 Terminal 53 Low Voltage.

l Parameter 6-11 Terminal 53 High Voltage.

l Parameter 6-12 Terminal 53 Low Current.

l Parameter 6-13 Terminal 53 High Current.

l Parameter 6-14 Terminal 53 Low Ref./Feedb. Value.

l Parameter 6-15 Terminal 53 High Ref./Feedb. Value.

l Parameter 6-17 Terminal 53 Live Zero.

l Parameter 6-20 Terminal 54 Low Voltage.

l Parameter 6-21 Terminal 54 High Voltage.

l Parameter 6-22 Terminal 54 Low Current.

l Parameter 6-23 Terminal 54 High Current.

l Parameter 6-24 Terminal 54 Low Ref./Feedb. Value.

l Parameter 6-25 Terminal 54 High Ref./Feedb. Value.

l Parameter 6-27 Terminal 54 Live Zero.
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Digital Input

If a low-level signal is available, the DI32 (digital input 32) can be programmed to stop inverse or to external interlock, and an external

interlock delay can be configured. The type of pulse to trigger can be configured from the digital I/O mode drop-down list.

8.5.2.2 The Set-up Tab

The Set-up tab contains the configuration interface for the cascade controller, parameter group 25-** Cascade Controller. The cascade

principle can be configured to Basic Cascade Ctrl or Motor Alternation Only (VLT® AQUA Drive FC 202 only).
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Figure 125: Configuration Interface for Parameter Group 25-** Cascade Controller

8.5.2.2.1 Cascade Principles

Basic Cascade Control

Select basic cascade control to configure:

l Motor start.

l Pump configuration.

l Staging/destaging settings.
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Figure 126: View of Basic Cascade Control Set-up Tab

Table 7: View and Selection Descriptions

View Description

Motor start The view defines the configuration principle:

l Direct on line – each lag pump is cut in directly via a contactor.

l Soft starter – must be used for all fixed-speed pumps and can
be used to replace traditional contactors. When using soft
starters, a delay is added from the staging signal occurs until
staging takes place. The delay is required due to the ramp time
of the fixed speed pump.

Enable pump cycling The view defines whether the pump cycling is enabled or not:

l Disabled - lag and lead pumps are cut in to have equal hours
run for each pump.

l Enabled - lag pumps are cut in according to the first-in, last-
out principle.
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Table 7: View and Selection Descriptions - (continued)

View Description

Fixed lead pump This view defines whether a drive uses a fixed lead pump or not.
The lead pumps are connected directly to the relays on the drive
control card. This is shown in Figure 126. To obtain equal hours of
operation within the fixed-speed pumps, the lead pump can be
alternated. Timers on the relay outputs monitor the hours run of
each pump. When a pump is not operating for a long time, corro-
sion may become an issue. When it is configured for alternating
lead pump, select Alternation details to set up principles for alter-
nation.

Lead pump alternation This view instructs the drive to change the lead pump so all
pumps run for the same period. The following options are avail-
able:

l Off - no lead pump alternation occurs.

l At staging - lead pump alternation occurs at pump staging.

l At command - lead pump alternation occurs at explicit
commands.

l At staging or command - lead pump alternation occurs at
pump staging and at explicit commands.

Alternation time interval In this view, define the time period between automatic alternation
of the lead pump:

l 1–999.9 h - when the time expires, the lead pump alternates.

Alternation time value This view contains the actual value of the alternation timer.

Alternation predefined time In this view, set the time to perform an alternation. The time for-
mat depends on the settings configured in the drive.

Alternate if load <50% In this view, define whether the lead pump must be alternated:

l Enabled - pump alternation is carried out only if the capacity is
equal to or below 50%.

Staging mode at alternation In this view, configure the staging mode at alternation and deter-
mine the time of the variable-speed pump deceleration:

l Quick.

l Slow.

Delay before cutting in next pump In this view, set the time between stopping the old lead pump and
starting another. Range: 0.1–5.0 s.

Delay before cutting in on mains Time delay before a fixed-speed pump is staged on according
to the normal staging sequence. When it expires, a fixed-speed
pump must be staged on according to normal staging. Range:
0.1–5.s.

Staging/destaging settings In this view, configure when to add and remove a stage from a
running application. A stage is a representation of a 100% pump.
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Table 7: View and Selection Descriptions - (continued)

View Description

Staging bandwidth (SBW) In this view, define the band around the head setpoint and con-
figure it as a percentage of the maximum reference. If the actual
head exceeds the bandwidth for a specified time and the speed is
at motor speed high limit, a stage is added. If the speed is at motor
speed low limit, a stage is removed. Range: 1–100%.

Override bandwidth (OBW) Preserves a stable head in the application. When quick changes
in the system demands occur, the override bandwidth must add/
remove a stage immediately when the actual exceeds override
bandwidth. To avoid unintended staging until the head has set-
tled after start, override bandwidth has a delay until the lead
pump has reached motor nominal speed or motor speed high
limit after a start command. Range: SBW to 100%.

Fixed speed pumps staging bandwidth (FSBW) Ensures that the cascade controller continues if the drive issues an
alarm. Keeping the head on the setpoint requires a frequent stag-
ing and destaging. When only fixed–speed pumps are running, a
wider bandwidth (FSBW) is used instead of SBW. Range: SBW to
OBW.

OBW timer Avoids frequent staging/destaging. The OBW timer prevents stag-
ing a pump until the application pressure is stabilized. Range: 0–
300 s.

SBW staging delay Delay between the feedback signal being below the staging band-
width and a lag pump being added. SBW destaging delay is the
time between when the feedback signal is above the staging
bandwidth and when a lag pump is removed. Range: 0–3000 s.

Ramp-down delay and ramp-up delay For use with soft starters. The ramp-down delay is for setting the
lead pump ramp-down delay before staging a fixed-speed pump
on. Ramp-up delay is for setting the lead pump ramp-up delay be-
fore a fixed-speed pump is destaged.

Stage- and destage threshold The percentage of maximum pump speed to stage on and to
destage fixed-speed pump. The thresholds must be configured as
a percentage of motor speed high limit.

Destaging speed To avoid an overshoot when adding a fixed-speed pump, the
variable-speed pump ramps to motor speed low limit. When the
variable pump reaches staging speed, the fixed-speed pump is
staged on. To avoid an undershoot when removing a fixed-speed
pump, the variable-speed pump ramps to motor speed high limit.
Available options: RPM or Hz.

Enable staging function Avoids frequent staging of fixed-speed pumps. Enabling the
checkbox starts the stage function timer. Enable destage function
ensures that the lowest numbers of pumps are running to save
energy and to avoid dead head water circulation in the variable-
speed pump. Enabling the checkbox starts the destage function
timer.
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Table 8: Number of Pumps Configurable from the Drop-down List

Function Number of pumps

Fixed lead pump 2–3

Alternating lead pump 2
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Figure 127: Alternation Details

If configuring the lead pump alternation At command or At staging or command, the alternation event can be configured to:

l External - Alternation takes place when a signal is applied to 1 of the digital inputs in the terminal strip.

l Alternation time interval - Alternation takes place every time the alternation time interval expires.

l Sleep mode - Alternation takes place each time the lead pump goes into sleep mode. Set the no-flow function to sleep mode or

apply an external signal for this function.

l Predefined time - Alternation takes place at a defined time of the day. If Alternation predefined time is set, the alternation is carried

out every day at the specified time.
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Figure 128: Staging and Destaging Details

Stage function time is the time before staging on a fixed speed if the lead pump is at maximum speed. The stage timer starts when the

adjustable-speed pump is running at motor speed high limit with 1 or more constant-speed pumps stopped. When the timer expires,

a fixed-speed pump is staged. The destage function time is the time before staging on a fixed speed if the lead pump is at minimum

speed. It starts when the adjustable-speed pump is running at motor speed low limit with 1 or more fixed-speed pumps in operation.

When the timer expires, a stage is removed avoiding dead head water circulation within the adjustable-speed pump.

If the Destage at no-flow checkbox is enabled, a stage is removed when there is a no-flow situation.

Motor Alternation Only

In Motor alternation only, 1 drive and 2 pumps are connected through contactors to both the drive and to mains. The functionality

is used to allow the alternation between pumps that share a drive. The alternation takes place at an external command signal or a

preprogrammed event.

8.5.2.3 The System Optimizing Tab

The System optimizing tab provides a simple way to start and stop the cascade controller. It allows configuration of:

l PID controller.

l Feedback low-pass filter.
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Figure 129: Start and Stop Cascade Controller

Table 9: Description of PID functions

Field Description

PID anti-windup Controls the integration of the PID controller. If the checkbox is
enabled, the PID controller stops integrating the error between
the feedback and the setpoint reference if it is not possible to ad-
just the output frequency of the drive to correct the error. This
situation can occur when the drive has reached the minimum or
maximum output frequency, or when the drive is stopped. If the
checkbox is disabled, the PID controller continues integrating the
error between the feedback and setpoint reference, even though
the drive cannot adjust its output frequency to correct this error.

PID proportional gain Adjusts the output of the PID controller of the drive based on the
error between the feedback and the setpoint reference. A quick
PID controller response is obtained using a large value. If too large,
the drive output frequency may become unstable. The value is
configurable from 0–10.00.

PID integral time The duration of integrating the error between the feedback and
the setpoint reference to ensure the error approaches 0. Quick
speed adjustments are obtained using a short duration. At a too
short value, the drive output frequency may become unstable.
The time is configurable from 0.01–10000.00 s.
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Table 9: Description of PID functions - (continued)

Field Description

PID differentiation time The time the differentiator monitors the rate of change of the
feedback. If it is quickly changing, it adjusts the output of the PID
controller to reduce the rate of change of the feedback. Quick PID
controller responses are obtained using a long duration of time.
However, at too large values, the drive output frequency may be-
come unstable. Differential time is useful in situations where fast
responses and precise speed control are required. The time is con-
figurable from 0.00–10.00 s.

Terminal 54 Filter Time Constant A first-order digital low-pass filter constant for suppressing elec-
trical noise from terminal 54. A high time constant improves the
dampening, but also increases the time delay through the filter.
The value can only be adjusted while the drive is stopped. The
time constant can be configured from 0.001–10.000 s.

8.5.2.4 The Service Tab

The Service tab provides a simple way to make cascade controller service.

Table 10: Service Tab Views

View Description Basic cascade controller Extended cascade controller

Cascade status – ✓ ✓
Pump status Readout of the status for each

pump selected with a string,
which consists of the pump
number and the status of the
pump. A readout with 2 pumps
could be 1:D 2:O.

l 1:D – Pump 1 running on
drive.

l 2:O – Pump 2 off.

✓ ✓

Lead pump Shows the actual lead pump in
the application. When an alter-
nation takes place, the field is
updated to reflect the current
lead pump.

✓ ✓

Manual alternation Select a new lead pump. The
items available from the drop-
down list are Off for the number
of pumps.

✓ �
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Table 10: Service Tab Views - (continued)

View Description Basic cascade controller Extended cascade controller

Relay status Select relay status to update the
status of the relays. The status
can be

l On - the relay is activated.

l Off - the relay is deactivated.
The values can only be updated
if the drive is online.

✓ ✓

Relay ON time Monitors the total hours run of
the connected relay. The resolu-
tion is in hours run. Reset relay
counter resets all relay on-times.
It is only available if the drives
are connected online.

✓ �

Pump interlock Disables a certain pump and is
configurable from a checkbox
at each pump.

✓ �

Pump ON time Monitors the total hours run of
the connected pump. The res-
olution is in hours run. Reset
clears the hours run of a specific
pump.

✓ �

Current run-time hours Readout of the total number of
hours run for each pump since
last reset. The time is used to
balance the hours run between
pumps.

� ✓

Pump total lifetime hours Total hours run for each con-
nected pump.

� ✓

Manual pump control Readout of the command para-
meter that allows manual con-
trol of individual pump states.

� ✓

Reset relay counter Resets all relay on-times. Only
available if the drive is online.

� ✓
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Figure 130: Service Tab Basic Cascade Controller
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Figure 131: Service Tab Extended Cascade Controller
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Table 11: Status Descriptions

View Status Status description

Disabled The cascade controller is disabled.

Emergency All pumps have been stopped by a coast/
coast inverse or an external interlock com-
mand applied to the drive.

Off All pumps have been stopped by a stop
command applied to the drive.

In open loop Configuration mode has been set for open
loop. All fixed-speed pumps are stopped,
and the variable-speed pump continues to
run.

Frozen Staging/destaging of pumps has been
locked and the reference is locked.

Jogging All fixed-speed pumps are stopped. When
stopped, the variable-speed pump runs at
jog speed.

Running A start command is applied to the drive
and the cascade controller controls the
pumps.

Running FSBW The drive is tripped and the cascade con-
troller controls the fixed-speed pumps
based on fixed-speed bandwidth.

Staging The cascade controller is staging fixed-
speed pumps.

Destaging The cascade controller is destaging fixed-
speed pumps.

Alternating The lead pump alternation selection is
different than Off and an alternation se-
quence is taking place.

Cascade status

Lead not set No pump is available to be assigned as
variable-speed pump.

X Disabled. The pump is interlocked either
via pump interlock or signal on a digital in-
put programmed for pump interlock in dig-
ital inputs.

Off Stopped by the cascade controller, but not
interlocked.

D Running on drive, regardless of whether
the variable-speed pump is connected di-
rectly or controlled via a relay in the drive.

Pump status

R Running on mains. Fixed-speed pump run-
ning.
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Table 11: Status Descriptions - (continued)

View Status Status description

On The relay is activated.Relay Status(1)

Off The relay is deactivated.

No operation The function is disabled.

Online Makes the pump available to the cascade
controller.

Alternate On Forces the selected pump to be the lead
pump.

Offline-Off Turns off the pump and makes the pump
unavailable for cascading.

Offline-On Turns on the pump and makes the pump
available for cascading.

Manual pump control (2)

Offline-Spin Initiates a pump spin.

1) Only available in basic cascade controller.

2) Only available in extended cascade controller.

Relay status enables readout of the function and status of each relay.
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Figure 132: Relay Status

8.5.3 Extended Cascade Controller Options

8.5.3.1 Overview of Extended Cascade Controller Options

The Extended Cascade Controller offers 2 cascade modes that are not available in basic cascade control. The 2 modes are:

l Master/Follower.

l Mixed Pumps.
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8.5.3.2 The Set-up Tab

Set-up is the interface for setting up the add-on cascade controller option. The Cascade mode drop-down list is extended with Master/

Follower and Mixed Pumps.
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Figure 133: Cascade Mode Drop-down List

8.5.3.3 Master/Follower

The master/follower function allows configuring:

l Motor start.

l Pump configuration.

l Connections.

l Staging/destaging.

l Master pulse output signal.

l Spin time unused pump.

l Run-time balancing.
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Figure 134: Master/Follower

The motor start drop-down list is similar to the configuration available in  Basic Cascade Control.

A drive controls each pump, and the number of drives corresponds to the number of pumps. Staging and destaging are done based on

the speed of the drive. The master drive operating in closed loop controls the constant pressure. Up to 6 pumps can be controlled with

the VLT® Extended Cascade Controller MCO 101 and up to 8 pumps with the VLT® Advanced Cascade Controller MC 102.

Select Connections to configure the relay function for each relay in the application.
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Figure 135: Configure Relay Options

NOTE: The number of available relays depends on the add-on option.

To set up the function of each relay, double-click the Value field and select the relay from the drop-down list. If add-on option MCO 102 is

installed, the relay option VLT® Relay Card MCB 105 may also be used as an expansion.

Select Staging/Destaging settings to configure when to add and remove a stage from a running application. All stages are a

representation of 100% pumps in Master/Follower.
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Figure 136: Staging and Destaging Details

Table 12: Staging and Destaging Description

Field Description

Normal operating range The allowed offset from the setpoint before a pump may be
added or removed. The system must be outside of the limit for the
time specified in Staging delay.

Override limit The allowed offset from the setpoint before a pump is immedi-
ately added or removed.
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Table 12: Staging and Destaging Description - (continued)

Field Description

Autotune stage/destage threshold Optimizes the threshold values during operation. The settings
are updated to avoid pressure overshoots and undershoots when
staging and destaging.

Autotune stage on/off speeds Stage on and off speeds are continually autotuned during opera-
tion. Settings are optimized to ensure high performance and low
energy consumption.

All supported stages On and Off settings can be configured in RPM or Hz. Select Example to see a configuration example of 3 pumps.

Ramp-down delay and ramp-up delay are only configurable when motor start is configured to soft starter.

Select Master pulse output signal to configure terminal 27 on the master drive.
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Figure 137: Master Pulse Output Signal

In some applications, not all pumps are used regularly. Select Spin time unused pump to configure the time a pump is allowed to idle.
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Figure 138: Spin Time Unused Pump

Select Runtime balancing to balance the running hours of the available pumps. Three balancing priorities are available for each pump.
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Figure 139: Balancing Running Hours

8.5.3.4 Mixed Pumps

Select Mixed pumps to configure:

l Motor start.

l Pump configuration.

l Pump size.

l Connections.

l Alternation details.

l Staging/destaging settings.

l Spin time unused pump.

l Runtime balancing.
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The motor start drop-down list is similar to  Basic Cascade Control, but with the additional possibility to configure star/delta.

Mixed Pumps Cascade Mode can be configured to:

Table 13: Mixed Pump Cascade Mode

Mode Description

Mixed pump A mix of variable-speed pumps connected to drives and more
fixed-speed pumps.

Unequal size pump Limited mix of fixed-speed pumps in different sizes.

Mixed pump with alternation Alternates the drive between 2 pumps along with controlling
more fixed-speed pumps.

Select Pump size to configure the fixed pump capacity in the application. All variable-speed pumps are read-only and 100% in capacity.
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Figure 140: Configure Fixed Pump Capacity

For configuration of connection, refer to 8.5.3.3 Master/Follower. For mixed pump alternation details configuration, refer to  Basic

Cascade Control.

The dialog Staging and destaging details is similar to  Basic Cascade Control with the additional option to configure minimum speed

destage delay. Configure for how many seconds the lead pump must run at minimum speed while system feedback is in normal

operation band. When the time has elapsed, the pump turns off to save energy.
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Figure 141: Staging/Destaging

Spin time unused pump and Runtime balancing configurations are similar to the master/follower configuration.

8.6 Drive File Manager Plug-in

8.6.1 Customer-specific Initialization Values - CSIV

The Drive file manager provides the functionality to download files containing customer-specific initialization values (CSIV), language

files, and application wizard files to the drive. CSIV files contain parameter sets that can be used to initialize the drive to reduce the time

for commissioning. Files can only be flashed via the fieldbus RS485 and USB with the drive serial address configured to 1.

Table 14: Available Features

View drive
flash file
system

Download
CSIV files

Delete CSIV
files

Download
language
files

Delete
language
files

Download
application
wizard files

Delete
application
wizard files

Splash
screen

VLT® Micro
Drive FC 51

N/A N/A N/A N/A N/A N/A N/A N/A

VLT® HVAC
Basic Drive
FC 101

N/A N/A N/A N/A N/A N/A N/A N/A

VLT® HVAC
Drive FC 102

Yes Yes Yes Yes Yes Yes Yes Yes

VLT® AQUA
Drive FC 202

Yes Yes Yes Yes Yes Yes Yes Yes

VLT® Au-
tomation-
Drive FC 302

Yes Yes Yes Yes Yes Yes (1) Yes Yes

Danfoss A/S © 2025.07                                                                                                                                                                     AQ283728700891en-001201 / 130R0466 | 131



Table 14: Available Features - (continued)

View drive
flash file
system

Download
CSIV files

Delete CSIV
files

Download
language
files

Delete
language
files

Download
application
wizard files

Delete
application
wizard files

Splash
screen

Derived ver-
sions of the
FC Series

Yes Yes Yes Yes Yes Yes Yes Yes

VLT® Ad-
vanced Filter
AAF 006

Yes Yes Yes Yes Yes N/A N/A N/A

1) Only FC 302 from firmware version 6.6x.

The functionality is available as a plug-in named Drive File System and is accessible both from the network and project nodes.
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Figure 142: Drive File Manager Plug-in

From the network node, it is only possible to view the content in the Drive flash system. It requires a change of the drive serial protocol

parameter 8-30 Protocol to [1] FC MC. CSIV and language files can only be downloaded from the project node.

8.6.2 Creating New CSIV Files

NOTE: To import existing CSIV files or language files to the list, select Import file from the menu.

NOTE: To export CSIV files containing initialization values to a file, select Export file from the menu. From the file menu, it

is possible to cut, copy, paste, delete, or rename existing files from the list.

Procedure

1. Right-click the right pane of the Drive File Manager.

2. Select New File and CSIV File.
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Figure 143: Create CSIV Files

Ü An empty CSIV file is created and listed in the right view with the default name starting from 1.

8.6.3 Configuration of CSIV Files

The CSIV file content is autogenerated based on the settings configured in the File menu.

l Full change set builds up the CSIV file content based on the user-made changes in the project including all the dependent

parameters.

l Minimal change set builds up the CSIV file content based on user-made changes only. Selecting this option, the CSIV files are

independent of the drive firmware version, except if 1 of the user-configured parameters is not available.

Use an editor to configure the CSIV file. To open the editor, double-click a file from the list or select Edit File from the menu.
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Figure 144: Parameter Settings Imported from the Project and the Actual CSIV File Content

The left view contains the parameter settings imported from the project. The right view lists the actual CSIV file content.

l Edit the relevant parameter settings in the Edit parameters below view.

l It is possible to undo the changes made from the Options menu.

l Revert parameters to project drive settings apply to initialization values to CSIV file contents corresponding to the original project.

l Reset to default values resets all parameters to factory configuration and erases the CSIV file content.

l Click Save to save parameter settings from the file content to the CSIV file.

l Click Cancel to discard all changes and close the CSIV editor.

As part of the CSIV content, the drive information is also saved to the file. When opening the file in the CSIV editor, a validation is made to

check for compatibility.
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Figure 145: Validation

When parameter settings have been saved to the file, open it for validation.

8.6.4 Drive File Manager

Files can be downloaded or existing files deleted in the drive via the Drive File Manager available from the menu.
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Figure 146: Drive File Manager

The drive is set into service mode when opening the Drive File Manager.

NOTE: If the connection is lost, or the drive is power cycled, the drive remains in service mode. It can be forced back to

normal mode with the Software upgrade plug-in.
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Figure 147: Service Mode

The Drive File Manager is divided into a left pane named Project drive and a right pane named Connected drive.

l Project drive lists the files in the project.

l Connected drive lists the files present in the drive flash file system.
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Figure 148: Present Files

There are 3 buttons in the middle of the view. The right arrow transfers the files from the project to the drive flash file system.

Figure 149: Right Arrow

The left arrow transfers the files from the drive flash file system to the project.

Figure 150: Left Arrow

The exit button closes the Drive File Manager and switches the drive back to normal mode.

Figure 151: Exit
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8.7 Functional Safety Configuration Plug-in

8.7.1 Introduction

The VLT® Safety Option MCB 15x Series is defined in the safety configuration plug-in:

l Configuration of the safety functions for safe motion shuts down the drive if an error occurs.

l Setting of:

¢ Limit values.

¢ Braking ramps for the safety functions.

¢ Monitoring of motion sequences.

The VLT® AutomationDrive FC 301/FC 302 Operating Guide contains important safety systems information to be used to mount and set

up the speed monitoring safety functions of the MCB 15x module.

2

3

MCT 10

1
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Figure 152: System Overview

8.7.2 Safe Option Compatibility

The VLT® Safety Option MCB 15x Series is supported from SW version 6.64 of VLT® AutomationDrive FC 301/FC 302. Previous versions are

not supported. MCB 15x Safe Plug-in supports the following fieldbuses:

l Serial communications:

¢ RS232 to RS485

¢ USB to RS485

l USB

l PROFIBUS DP-V1
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The VLT® Motion Control Tool MCT 10 safe plug-in for the VLT® Safety Option MCB 15x Series offers the following features:

l Offline project planning and preparation for safety functions.

l Commissioning of safety configurations.

l Creating backups of safety configurations.

l Safe option diagnosis.

l Monitoring the behavior and fault codes of active drives.

8.7.3 Access

8.7.3.1 Password Management

Access to the VLT® Safety Option MCB 15x Series is restricted with passwords. The password is requested at every commissioning of a

new setup for the device.

8.7.3.2 Accessing the Safe Plug-in for VLT® Safety Option MCB 15x Series

Procedure

1. Expand the drive's network or project view.

2. Expand the relevant drive to show its contents.
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Figure 153: The Safe Plug-in for MCB 15x (Safety) shown with Functional Safety Icon in Project Tree

If there are multiple separate online or offline drives, select the relevant drive to monitor from the structure tree.

NOTE: The parameters that can be edited using the safe plug-in for MCB 15x are also included in parameter

group 42-** Safety Functions in the All Parameters group of the structure tree. These parameters can only be

edited using the safe plug-in for MCB 15x.

To review parameter group 42-** Safety Functions in the All parameters view, expand the All parameters group beneath the

wanted drive and select the parameter group 42-** Safety Functions entity. The parameter grid is shown on the right.

8.7.4 Safe Plug-in Interface

8.7.4.1 Overview of the Safe Plug-in Interface

The layout of the plug-in is divided into separate sections that are all described in more details in this chapter.
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Figure 154: The Opening Tab of the Safe Plug-in for VLT® Safety Option MCB 15x Series Plug-in Interface (Operating in Offline Mode)

The safe plug-in for the MCB 15x features tooltips for all plug-in interface components. Briefly hovering the mouse cursor over any

interface component reveals a tooltip detailing the current option, LED, or tab header. Refer to these tooltips for quick and easy help

information.

e3
0b

c9
35

.1
1

Figure 155: Tooltip Example

8.7.4.2 Areas in the Safe Plug-in Interface

8.7.4.2.1 Information and Administration Ares
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Figure 156: Safe Plug-in for VLT® Safety Option MCB 15x Series Information and Administration Area

The information area at the top of the plug-in interface shows the current safe plug-in for MCB 15x profile name and notifies about

pending changes.
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Depending on the mode, further options are available in the information area.

l Offline mode: If a drive is connected, press Write to drive and upload the configuration to the MCB 15x.

l Online mode: Two more selections are present in the Information area:

¢ Administration

¢ Change password

The Notification icon is shown when there are changes pending for the drive that have not yet been written to it. This icon is shown at

every configuration update. The icon is removed from the view only after a successful commissioning procedure.

8.7.4.2.2 LED Status Area

The left-hand side of the safe plug-in for the VLT® Safety Option MCB 15x Series contains the Status pane. The Status pane contains

informative LED status icons that help to monitor the functionality and status of the safe plug-in for MCB 15x configuration entities.
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Figure 157: LED Status Area

NOTE: The LED icons are active only when the safe plug-in for MCB 15x is accessed in online network mode. When

working in offline project mode, the LEDs remain inactive (gray).

Table 15: LED Status Information

LED status Description

Green OK state - the option is enabled or active.

Flashing green Pending state - the option is pending. This state applies only to
DI1 and DI2 LEDs.

Yellow Active state - the option is active.

Flashing red Warning state - the option has encountered a warning state.
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Table 15: LED Status Information - (continued)

LED status Description

Red Error state - the option has encountered an error.

Gray Off state - the option is either disabled, offline, or inactive.

Table 16: LED Status Information

LED Status

DI1 Status of digital input 1.

DI2 Status of digital input 2.

S37 Status of S37 safe output for terminal T37 on the drive.

STO Status of Safe Torque Off.

SS1-A Status of Safe Stop 1 A.

SS1-B Status of Safe Stop 1 B.

SLS-A Status of Safely Limited Speed A.

SLS-B Status of Safely Limited Speed B.

SMS Status of Safe Maximum Speed

Power cycle required This LED lights up when the device requires a power cycle.

Yearly test needed Test digital inputs once a year. A warning indicates when it is time
to perform the test.

Blank initial If the LED lights up, the MCB 15x is in a blank initial state, that is,
in factory settings. When writing to the MCB 15x for the 1st time,
provide a new password.

Error The MCB 15x has detected an error. The specific fault code is
shown in the fault code display below the error LED: For more
information regarding fault codes, refer to 12.3.3 Warnings and
Alarms.

8.7.4.2.3 Configuration Area

The configuration area contains dedicated sections/tabs for configuring the safety functions.

The sequence of tabs shows the order in which the settings should be configured.

The following sections detail the contents of the configuration tabs:

l General Speed Monitoring.

l Safe Input.

l Safe Stop 1.

l Safely Limited Speed.

l Safe Maximum Speed

The last tab, Parameters, contains a table layout of all configuration options, intended for advanced users.
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8.7.4.3 Tabs in the Safe Plug-in Interface

8.7.4.3.1 General Speed Monitoring

The General Speed Monitoring tab contains primary and general information regarding the encoder/proximity switch feedback setup

details.
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Figure 158: Speed Monitoring Configuration Tab

The left side of the tab contains the following configuration options:

Table 17: Options for General Speed Monitoring

Option Description

Measured speed source This option defines the measured speed feedback source. The fol-
lowing options are available:

l Safe plug-in for VLT® Safety Option MCB 15x Series - the
feedback source is the safe plug-in for MCB 15x.

l None - no feedback source is used.

l Factory setting: [Safe plug-in for MCB 15x].

Mounting type This option defines where the encoder is mounted. The following
options are available:

l Gear mounted - the encoder reading the speed is mounted on
a shaft using a gear system.

l Motor shaft mounted - the encoder is mounted directly to the
motor shaft.

l Sensorless - the drive is mounted with the VLT® Sensorless
Safety MCB 159 option. The encoder senses the motor speed
via back EMF.
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Table 17: Options for General Speed Monitoring - (continued)

Option Description

Gear ratio This option defines the ratio between the motor shaft and the en-
coder speed.

Range: 0.0001 and 32.0000.

Factory setting: 1.0000.

VLT® Safety Option MCB 150 encoder resolution This option defines the encoder resolution connected to the safe
plug-in for MCB 15x.

Range: 1 and 4096 PPR for HTL, and 1 and 1000 PPR for TTL.

Factory setting: 1024 PPR.

Encoder direction This option provides the option to change the detected encoder
rotation direction without altering the wiring to the encoder itself.
The following options are available:

l Clockwise - that is positive feedback when the encoder rotates
clockwise.

l Counterclockwise - that is positive feedback when the encoder
rotates counterclockwise.

Factory setting: [Clockwise].

Feedback type This option defines the feedback type. The following options are
available:

l With direction info - the feedback provides direction
information, for example an encoder.

l Without direction info - the feedback does not provide
direction information (proximity switch configuration).

Factory setting: [With direction info].

Feedback filter This option defines the frequency used by the feedback filter for
low-resolution encoder or proximity switch if the resolution is low.

Range: 0.01–200 Hz (off ).

Factory setting: [200 Hz (off )].

Zero speed timer This option allows the speed to be below 120 RPM when SLS is ac-
tive before STO is engaged.

Range: 0 s and 10000 s.

Factory setting: [10].

8.7.4.3.2 Safe Input

The Safe Input tab details the input channel, settings, failure reaction, and reset functions that are mapped into the VLT® Safety Option

MCB 15x Series.
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Figure 159: Safe Input Configuration Tab

The Safe Input tab contains several sections and configuration possibilities.
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Table 18: Options for Safe Input

Option Description

DI1 safe function This option defines the safe function used by DI1. The following
options are available:

l STO - Safe Torque Off is used as the safe functions by DI1.

l SS1-A - Safe Stop 1 A is used as the safe function by DI1.

l SS1-B - Safe Stop 1 B is used as the safe function by DI1.

l SLS-A - Safely Limited Speed A is used as the safe function by
DI1.

l SLS-B - Safely Limited Speed B is used as the safe function by
DI1.

l Disabled - The DI1 safe function is disabled.
Factory setting: STO.

DI1 type This option defines the DI type used. The following options are
available:

l NCNC - NCNC type is used.

l Antivalent - NO/NC (antivalent) type is used.

l NC - 1 NC input type is used.

DI1 restart behavior Restart of the MCB 15x configures the DI1 start behavior. The fol-
lowing options are available:

l Manual - The restart is performed manually.

l Automatic - The restart is performed automatically.
Factory setting: Manual.

DI2 This option defines the safety function used by DI2. The following
options are available:

l STO - Safe Torque Off is used as the safe functions by DI2.

l SS1-A - Safe Stop 1 A is used as the safe function by DI2.

l SS1-B - Safe Stop 1 B is used as the safe function by DI2.

l SLS-A - Safely Limited Speed A is used as the safe function by
DI2.

l SLS-B - Safely Limited Speed B is used as the safe function by
DI2.

l Disabled - The DI2 safe function is disabled.
Factory setting: STO.
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Table 18: Options for Safe Input - (continued)

Option Description

DI2 type The option defines the DI2 type used. The following options are
available:

l NCNC - NCNC type is used.

l Antivalent - NO/NC (antivalent) type is used.

l NC - 1 NC input type is used.

DI2 restart behavior This option defines the DI2 restart behavior. The following options
are available:

l Manual – The restart is performed manually.

l Automatic – The restart is performed automatically.
Factory setting: Manual.

Table 19: Options for Input Settings

Option Description

DI1 discrepancy time This option defines the time for the DI1 signal discrepancy.

Range: 0–5000 ms.

Factory setting: 10 ms.

DI1 stable signal time This option defines the time for the DI1 signal to become stable.

Range: 0–5000 ms.

Factory setting: 10 ms.

DI2 discrepancy time This option defines the time for the DI2 signal discrepancy.

Range: 0–5000 ms.

Factory setting: 10 ms.

DI2 stable signal time This option defines the time for the DI2 signal to become stable.

Range 0–5000 ms.

Factory setting: 10 ms.

Table 20: Options for Failure Reaction

Option Description

External failure reaction This option defines the reaction that is executed if there is an ex-
ternal failure. The following options are available:

l STO - STO is executed.

l SS1-A - SS1-A is executed.

l SS1-B - SS1-B is executed.
Factory setting: STO.
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Table 21: Options for Reset Settings

Option Description

Reset source This option defines the source for the reset signal for the safe
plug-in for MCB 15x. The following options are available:

l Drive Reset - The source is a drive reset.

l Drive Safe Reset - The source is a safe drive reset.

l Safe Option DI2_A - The source is MCB 15x DI2_A.
Factory setting: Drive Reset.

8.7.4.3.3 Safe Stop 1

The Safe Stop 1 tab allows setting specific scenarios for safe stopping of the drive using designated conditions.
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Figure 160: Safe Stop 1 Tab

The Safe Stop 1 tab contains the following separated sections with the following configuration possibilities:
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Table 22: Options for SS1-A

Option Description

Type This option defines the type for the safe stopping configuration. The following options
are available:

l Delay - a delay is used to stop the drive safely.

l Ramp - a ramp is used to stop the drive safely.
Factory setting: Delay.

The following configuration options are available when the type is set to delay:

Delay time This option defines the amount of time that
is used by the SS1 delay function to ramp
the speed down to 0 RPM.

Range: 0.1–3600 s.

Factory setting: 1 s.

Ramp profile This option defines the ramp profile set-
ting. The following options are available:

l Linear - a linear ramp is used for the
delay.

l S-ramp const. time - a constant time
ramp is used to stop the drive safely.

Factory setting: Linear.

Delta time This option defines the buffer time that is
added to the delay time before activating
STO.

Range: 0–99%.

S-ramp Ratio start This option is configurable only when S-
ramp constant time is selected as the ramp
profile. This option defines the proportion
of the total ramp-down time where the de-
celeration torque increases. The greater the
percentage value, the greater the jerk com-
pensation achieved, and thus the lower the
torque jerks in the application.

Range: 1–50%.

Factory setting: 50%.

Type: Delay

S-ramp Ratio end This option is configurable only when S-
ramp constant time is selected as the ramp
profile. This option defines the proportion
of the total ramp-down time where the de-
celeration torque increases. The greater the
percentage value, the greater the jerk com-
pensation achieved, and thus the lower the
torque jerks in the application.

Range: 1–50%.

Factory setting: 50%.
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Table 22: Options for SS1-A - (continued)

Option Description

The following configuration options are available when the type is set to ramp:

Ramping set-up This option defines the ramping setup
used. The following options are available:

l Slope - a sloping ramp is used.

l Time - a time ramp is used.

Deceleration rate This option is configurable only when slope
is selected for the ramping setup. This op-
tion defines the deceleration rate for the
SS1 slope-based ramp style.

Range: 1–30000 RPM/s.

Factory setting: 1500 RPM/s.

Ramp time This option is configurable only when time
is selected for the ramping setup. It defines
the time after which the safe plug-in for
VLT® Safety Option MCB 15x Series engages
the STO.

Delta V This option defines the tolerance between
the calculated speed and the actual speed
that the safe plug-in for MCB 15x allows.

Range: 1–10000 RPM.

Factory setting: 120 RPM.

Type: Ramp

Zero speed This option defines the speed at which the
safe plug-in for MCB 15x engages the STO.

Range: 1–600 RPM.

Factory setting: 10 RPM.
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Table 23: Options for SS1-B

Option Description

Type This option defines the type for the safe stopping configuration. The following options
are available:

l Delay - a delay is used to stop the drive safely.

l Ramp - a ramp is used to stop the drive safely.
Factory setting: Delay.

The following configuration options are available when the type is set to delay:

Delay time This option defines the amount of time that
is used by the SS1 delay function to ramp
the speed down to 0 RPM.

Range: 0.1–3600 s.

Factory setting: 1 s.

Ramp profile This option defines the ramp profile set-
ting. The following options are available:

l Linear - a linear ramp is used for the
delay.

l S-ramp const. time - a constant time
ramp is used to stop the drive safely.

Factory setting: Linear.

Delta time This option defines the buffer time that is
added to the delay time before activating
STO.

Range: 0–99%.

S-ramp Ratio start This option is configurable only when S-
ramp constant time is selected as the ramp
profile. This option defines the proportion
of the total ramp-down time where the de-
celeration torque increases. The greater the
percentage value, the greater the jerk com-
pensation achieved, and thus the lower the
torque jerks in the application.

Range: 1–50%.

Factory setting: 50%.

Type: Delay

S-ramp Ratio end This option is configurable only when S-
ramp constant time is selected as the ramp
profile. This option defines the proportion
of the total ramp-down time where the de-
celeration torque increases. The greater the
percentage value, the greater the jerk com-
pensation achieved, and thus the lower the
torque jerks in the application.

Range: 1–50%.

Factory setting: 50%.
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Table 23: Options for SS1-B - (continued)

Option Description

The following configuration options are available when the type is set to ramp:

Ramping set-up This option defines the ramping setup
used. The following options are available:

l Slope - a sloping ramp is used.

l Time - a time ramp is used.

Deceleration rate This option is configurable only when slope
is selected for the ramping setup. This op-
tion defines the deceleration rate for the
SS1 slope-based ramp style.

Range: 1–30000 RPM/s.

Factory setting: 1500 RPM/s.

Ramp time This option is configurable only when time
is selected for the ramping setup. It defines
the time after which the safe plug-in for
VLT® Safety Option MCB 15x Series engages
the STO.

Delta V This option defines the tolerance between
the calculated speed and the actual speed
that the safe plug-in for MCB 15x allows.

Range: 1–10000 RPM.

Factory setting: 120 RPM.

Type: Ramp

Zero speed This option defines the speed at which safe
plug-in for MCB 15x engages the STO.

Range: 1–600 RPM.

Factory setting: 10 RPM.

8.7.4.3.4 Safely Limited Speed

The Safely Limited Speed tab allows setting specific scenarios for safely limited speeds of the drives using designated conditions.
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Figure 161: Safely Limited Speed Tab

The safely limited speed contains the following separated sections with the following configuration possibilities:

Table 24: Options for SLS-A

Option Description

SLS setup This option defines the type of the safely limited speed setup. The
following options are available:

l SLS without ramp.

l SLS with ramp.

Ramp-down time This option is configurable only when the SLS with ramp is se-
lected in the SLS setup. It defines the ramp-down time for start
ramp.

Range: 0.1–3600 s.

Factory setting: 1 s.

Cut Off Speed This option defines the speed at which the fail-safe reaction is acti-
vated. This setting should equal the value of the speed limit para-
meter plus tolerance.

Range: 1–10000 RPM.
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Table 24: Options for SLS-A - (continued)

Option Description

Speed Limit This option defines the maximum allowed speed when the SLS
function is engaged. This is a speed unit measured in RPM.

Fail Safe Reaction This option defines the safety function that is engaged when the
maximum speed is exceeded. The following options are available:

l STO - Safe Torque Off is used.

l SS1-A - Safe Stop 1-A is used.

l SS1-B - Safe Stop 1-B is used.

Table 25: Options for SLS-B

Option Description

SLS Setup This option defines the type of the safely limited speed setup. The
following options are available:

l SLS without ramp.

l SLS with ramp.

Ramp-down time This option is configurable only when the SLS with ramp is se-
lected in the SLS Setup. It defines the ramp-down time for start
ramp.

Range: 0.1–3600 s.

Factory setting: 1 s.

Cut Off Speed This option defines the speed at which the fail-safe reaction is acti-
vated. This setting should equal the value of the speed limit para-
meter plus tolerance.

Range: 1–10000 RPM.

Speed Limit This option defines the maximum allowed speed when the SLS
function is engaged. This is a speed unit measured in RPM.

Fail Safe Reaction This option defines the safety function that is engaged when the
maximum speed is exceeded. The following options are available:

l STO - Safe Torque Off is used.

l SS1-A - Safe Stop 1-A is used.

l SS1-B - Safe Stop 1-B is used.

8.7.4.3.5 Safe Maximum Speed - SMS

NOTE: The SMS function is only available in drives with software version 8.31 or newer.
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Figure 162: Identification of Drive Software Version

If a VLT® AutomationDrive FC 302 has the VLT® Sensorless Safety MCB 159 option installed, the Safe Maximum Speed function is available.

The MCB 159 offers safe-speed monitoring and prevents continuously exceeding a defined speed value.

Use the SMS function to monitor machine speed. When the maximum allowed speed is exceeded, STO is activated as fail-safe reaction. In

the Safe Maximum Speed tab, it is possible to enable or disable the SMS function and to set the cut off speed in RPM.
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Figure 163: Safe Maximum Speed Configuration Tab

Table 26: Options for Safe Maximum Speed

Option Description

SMS enable The setting of this option selects whether or not the SMS function
is enabled:

l Inactive - the SMS function is not enabled.

l Active - the SMS function is enabled.

SMS Cut off Speed Set at which RPM the SMS function should cut off the drive.

8.7.5 Configuration

8.7.5.1 Configuration Modes

Configure the safe plug-in in online mode (PC connected to drive) or in offline mode (no PC connected to drive). In both cases, enter the

required values in the configuration dialogs to configure the plug-in.

NOTE: Multiple value entry fields in the configuration tabs are accompanied by recommended value settings that

appear below the text field. The recommended values are generated dynamically based on the user input of related and

dependent configuration options. To apply a recommended value to a field, press the underlined Apply link as it appears

below the wanted field.

Offline configuration
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When configuring the VLT® Safety Option MCB 15x Series in an offline project mode, the configuration is stored in the project. After

completing the configuration, connect to the PC and write to the drive.

NOTE: The LED status icons are not active in offline mode.

Online configuration

Changed settings within safe plug-in for MCB 15x are not applied before they are written to the device.

NOTE: If the safe plug-in for the MCB 15x interface is closed before the changes have been written to the drive, the

changes are lost.

8.7.5.2 Configuring the Safe Plug-in Online

Procedure

1. Connect the safe plug-in for MCB 15x to the drive.

2. Click Write to drive to apply changed settings in the safe plug-in. Writing the values to the drive always updates the entire device

package and not just the changed value.

8.7.5.3 Dependencies

Multiple configurable safety parameters depend on other safety parameter values. The safe plug-in for VLT® Safety Option MCB 15x

Series features notification dialogs that inform about the possible consequences. It is then possible to verify the changes and either

accept or discard the change.
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Figure 164: Dependencies Confirmation Dialog

When accepting the dependency dialog, both the change that caused the dependency dialog and all other configuration items listed in

the dependency dialog are applied.

8.7.5.4 Advanced Configuration Parameters

TIP: Prepare a complete list of all configuration items and their respective values before commissioning.

In the configuration area, the parameters section is a table format value entry for all configuration settings intended for advanced users.
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Figure 165: Parameters Configuration Tab

8.7.6 Commissioning

8.7.6.1 Commissioning Procedure

Procedure

1. Configure a safe plug-in for VLT® Safety Option MCB 15x Series.

2. Click Write to drive to upload to the drive.

Ü The status window opens.
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Figure 166: Writing to Drive Status Window

3. Enter the password when the Confirm password dialog pops up (default password: 12345678).

For more information on changing a password, refer to 8.7.7.3 Changing the Password.
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Figure 167: Password Entry Dialog

4. Press OK to continue OR press Cancel to discard the process and perform a rollback.

NOTE: When writing to a device in blank state, the user is prompted to provide a new password for the device.

Have the appropriate default password available at hand.
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Figure 168: Configuration Approval Dialog and Summary

Drives The top section of the summary
shows all drives affected by the
write procedure. If there are multiple
drives, press the drive titles in the
window to update parameters and
CRC accordingly.

Parameters This section details all the updated
parameters that were written to the
drive.

ID The parameter ID written. Name The name of the parameter written.

New values The value of the parameter that was
designated to be written to the drive.
This column must have the same
value as Received values. If not, an
error is shown.

Received values The value that was received from the
drive after the update procedure. This
column must have the same value as
New values. If not, an error is shown.

CRC This section shows the CRC values
that were generated from the
application side and the drive side.
These values must match. If not, an
error is shown.

5. When the configuration approval pops up, review the included summary.

6. Click Approve to confirm the changes and close the dialog window, OR click Cancel to discard the process and perform a

rollback.

Ü When the configuration is approved, the commissioning report is generated and shown.
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Figure 169: Commission Report Review, Save, and Print Dialog

7. Click Save to save the commission report in Rich Text Format.

8. Click Print to print the report.

9. When the commissioning process is complete, press [Reset] on the drive to reboot.

8.7.6.2 Commissioning Report

During the commission process, the commission report is generated based on a fixed template within the VLT® Motion Control Tool MCT

10 application. The report contains all data written to the drive.

The report is generated during the write-to-drive procedure and the data is gathered at the moment the report is generated. This report

contains the functions that must be tested, refer to the VLT® Safety Option MCB 15x Installation Guide and the VLT® Safety Option MCB

152 Installation Guide.

The contents and structure of the commissioning report are as follows:

l General introduction - general information and details about the report itself.

l Commissioning configuration - details regarding the commissioned setup and parameter configurations.

l Commissioning test - specific testing scenarios for the current setup. This section also contains CRC check procedure descriptions.

8.7.7 Operation

8.7.7.1 Using the Diagnostics Function

Procedure

1. Open the Safe Plug-in for VLT® Safety Option MCB 15x Series plug-in interface in network online mode.

2. Click Administration in the upper section of the interface.

Ü The Safe Plug-in for MCB 15x Administration Window opens.
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Figure 170: Safe Plug-in for MCB 15x Administration Window

3. Enter the Safe Plug-in for MCB 15x password configured for the drive.

4. Click Download to download the Safe Plug-in for MCB 15x event log.

5. Select a location to save the log file. The log is presented in simple text file format.

8.7.7.2 Using the Reset Function

NOTE: Resetting the device restores factory settings and erases any customized configuration on the device. To ensure

rollback possibility, back up the customized configuration before resetting.

Procedure

1. Open the safe plug-in for VLT® Safety Option MCB 15x Series plug-in interface in network online mode.

2. Click Administration in the upper section of the interface.

3. Click the Reset tab header to open the Resettab.

Ü The Reset Password window opens.
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Figure 171: Reset Password Window

4. Tick Yes, I want to reset Safe Option Configuration in the Drive for the drive to continue.
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5. Enter the master password configured for the drive to continue.

6. Click Reset to reset the drive password and configuration.

7. Press [Reset] on the drive to reboot.

8.7.7.3 Changing the Password

When working with the safe plug-in for VLT® Safety Option MCB 15x Series plug-in in network online mode, Change password is shown in

the information area of the plug-in interface.
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Figure 172: Safe Plug-in for MCB 15x Password Changing Window

Procedure

1. Click Change password.

2. Enter the current password into the Current password field.

3. Enter the new password into the New password field. The password length must be exactly 8 characters. The password is case

sensitive.

4. Confirm the new password by entering it again into the Confirm new password field.

5. If necessary, select the option Confirm to all blank initial drives to apply the new password to all new drives in the network.

6. Click Cancel to discard the procedure.

8.7.8 Status Plug-in

The Status plug-in is an online plug-in that shows the digital status words, control words, and alarm words.
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Figure 173: Selecting the Status Plug-in

The plug-in only shows the available parameters. For each control word and status word, it shows the value in hex, reference, and control

word profile. The plug-in shows all bits. Green LEDs indicate active bits (value = 1), while gray LEDs indicate inactive bits. The highlighted

text shows the meaning of the bit status.
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Figure 174: Example of Bit Status for Control Word

An information symbol in the left column of the screen indicates that a parameter has extra information. See Figure 174 for an example.

Click the information symbol to get information about a bit.
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Figure 175: Example of Bit Information
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Figure 176: Example of Maintenance Word
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Figure 177: Example of Digital Input

NOTE: When bit 6 is active, the signal on DI 37 is inactive, meaning that there is no signal present on the input.

Status plug-in used with fieldbuses

All fieldbuses supported by VLT® Motion Control Tool MCT 10 support the Status plug-in. While the plug-in is open, MCT 10 reads the

visible parameter constantly. This way, the plug-in updates automatically when values change.
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Loss of communication

If communication is lost, the plug-in turns yellow and sends a notification. The latest values are kept as they were before the

communication loss. When communication is recovered, the plug-in recovers automatically.

8.7.9 Drive Control Plug-in

8.7.9.1 Overview of the Drive Control Plug-in

The plug-in is supported by serial communication and USB.

For the plug-in to work, it is required to be connected to the drive that should be controlled.

To open the plug-in, select Drive control in the structure in the left window.
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Figure 178: Drive Control in Structure

A temporary page opens for accepting risks and configuring important parameters.
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Figure 179: Risks to Accept

8.7.9.2 Launching the Drive Control Plug-in

Prerequisite: To be able to launch the Drive Control plug-in, it is required to accept the risk.

Procedure

1. Tick I accept the risks.

2. Click Launch Drive Control.
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Figure 180: Launch Drive Control Button

Ü The Drive Control window opens.
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Figure 181: Drive Control Window

8.7.9.3 Setting the Control Word

At launch, the control word is set to 0400 but is not yet sent to the drive.
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Procedure

1. Set the control word in 1 of 2 ways:

– Use the checkboxes.
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Figure 182: Checkboxes for Setting Control Word

– Type the value directly in the Request in Hex field.
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Figure 183: Type in the Value Directly

Ü The control word is now set.
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Figure 184: Control Word Set

8.7.9.4 Starting Drive Control

Prerequisite: Set the control word before starting the drive control.

Procedure

1. Click Start control.

Ü The plug-in starts sending the control word and then reads the status word.
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Figure 185: Start Control Button

Ü The control word is sent cyclically until clicking Stop control or until communication fails. The control state bar runs while the

control word is being sent.
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Figure 186: Control State Bar Running

After a successful reading of a status, a notification is sent.
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Figure 187: Last Status Read Successfully

At loss of communication, the bits of the status view turn yellow, and an error appears.
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Figure 188: Loss of Communication
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Figure 189: Error at Loss of Communication

8.7.9.5 Changing Control Word Bits

Control word bits can be changed while the control word is being sent. While changing the control word, the values of Request in hex and

Current outgoing request differ.
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Figure 190: Request in Hex
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Figure 191: Values of Current Outgoing Request

Procedure

1. Enter the new value of the control word.

2. Click Update outgoing request.
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Figure 192: Update Outgoing Request Button

Ü After clicking Update outgoing request, the values are the same.
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Figure 193: Values Aligned in Request in Hex and Current Outgoing Request

8.7.9.6 Changing the Reference

Procedure

1. Change the reference in 1 of 2 ways:

– Enter the hex value directly in Request in hex.

– Enter the value in either decimal or percentage.

Values out of range are shown in pink.
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Figure 194: Value Out of Range

The Update outgoing request button is disabled until a valid value is set.

8.7.9.7 Open Drive Control Plug-in

When the Drive Control plug-in is open, the bus is locked, and it is not possible to scan or change parameter values.

It is possible to create a scope folder in a project that allows monitoring of relevant parameters while changing the control word via Drive

Control.
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Figure 195: Create Scope Folder in Project

Once the Drive Control plug-in is closed, the control word is restored to the value it had before starting the plug-in. Also other

parameters are only changed temporarily.

NOTE: Control word and other parameters used by Drive Control are written to flash instead of EEPROM. When power

cycling the drive, these values are restored to the values they had before the Drive Control was started. If Drive Control of

VLT® Motion Control Tool MCT 10 closes abnormally, the parameter restore process is not done. To restore the values after

an abnormal shutdown, power cycle the drive.

8.7.10 Decoder Plug-in

8.7.10.1 Purpose of the Decoder Plug-in

Use the Decoder plug-in for decoding Safe Option log files. The decoded log files are shown both inline (all information shown in 1 line)

and as an overview of a selected line.

8.7.10.2 Starting the Decoder Plug-in

Procedure

1. Click the Tools menu.

2. Select SafeOption Log Viewer.

Danfoss A/S © 2025.07                                                                                                                                                                     AQ283728700891en-001201 / 130R0466 | 175



e3
0b

t9
84

.1
0

Figure 196: Selecting the Plug-in

3. Click Browse to select a file.
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Figure 197: View of the Log Visualizer

4. Click the arrow button to expand the log area or the explanation area.

e3
0b

t9
86

.1
0

Figure 198: Expanding the Views
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Figure 199: Log File Shown in Log Visualizer

Files that require decoding have a 1-line explanation in the explanation area (right window). To get a better overview of a failure

description, select the failure to see an overview of the description at the bottom of the window.
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Figure 200: Failure Shown as Inline Text
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Figure 201: Overview of Failure Description

8.7.11 Condition-based Monitoring (CBM) Plug-in

8.7.11.1 Overview of the Condition-based Monitoring Plug-in

The CBM plug-in is an online-only plug-in for intuitive and progressive setup and monitoring of the CBM parameters. For project drives,

CBM parameters can be reviewed in a graphical format.

For the plug-in to function properly and for CBM parameters to be available online, a drive with CBM support and a valid CBM license

must be connected. To use CBM with project drives, a drive with the same type code and a valid CBM license must have been connected

previously. This allows the license information to be cached on the computer and reused for project drives.

CBM parameters can be configured using either the LCP or the CBM plug-in. However, it is not recommended to edit CBM parameters

through both interfaces simultaneously, as this may result in conflicting changes.

Once the plug-in is configured, parameter groups 45-** Condition Based Monitoring to 48-** CBM Applications appear in the left-hand

view.

For more information about condition-based monitoring, refer to the VLT® Condition-based Monitoring Programming Guide.

8.7.12 Service Log

The Service Log plug-in is available offline. It enables reading from the drive in the right view of the VLT® Motion Control Tool MCT 10

screen.

Pressing Read from drive overwrites any log files that are already in the log.
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Figure 202: Read from Drive Overwrites Log Files
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9 VLT® Software Customizer

9.1 Introduction

9.1.1 Overview of the VLT® Software Customizer

The VLT® Software Customizer is available from VLT® Motion Control Tool MCT 10 version 4.00. The tool enables customization of the

drive by modifying or creating unique splash screens, initial values, and SmartStart wizards.

The plug-in contains 3 independent features:

l SplashScreen: Add a custom logo that is shown during initialization of the drive. The SplashScreen supports:

¢ jpeg.

¢ png.

¢ bmp.

¢ gif.

l InitialValues: Define unique parameter default values based on application needs in a customer-specific initial values (CSIV) format.

Every time the drive is initialized, it starts with the custom values.

l SmartStart: Create custom SmartStart wizards that guide through predefined application steps, which simplifies the commissioning

process.

Furthermore, it is possible to write to the drive and test in the simulator. The Write to drive function writes files that have been created

or imported into VLT® Software Customizer. Test in simulator launches the LCP simulator for simulating a connection to a drive. In the

Settings menu, it is possible to show or hide the disclaimer.

Write to drive
Test in 
simulator

Settings
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Figure 203: Tool Tips for Navigation and Support
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Figure 204: A Mouse-over Highlights the Area Pointed at

When doing a mouse-over on 1 of the 3 features, the feature is highlighted, and a button is available. Click the button to open the

functions currently available for the selected feature.

Figure 205: Button for Opening Available Functions
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Figure 206: Example of Available Options for a Feature

9.1.2 Activation Key

The VLT® Software Customizer is an advanced tool that requires an activation key. To obtain the activation key, contact the local Danfoss

representative.
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Figure 207: Dialog Box for Entering the Activation Key

9.1.3 Disclaimer

When the activation key is active, a disclaimer appears.
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Figure 208: Disclaimer

Click OK to make the disclaimer disappear until the next restart of VLT® Motion Control Tool MCT 10.

To avoid seeing the disclaimer at each start-up, tick the Do not display again.

9.1.4 Changing the Disclaimer Settings

The settings for the disclaimer can be set at a later point.
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Procedure

1. Select Settings in the top menu.
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– Tick and click OK to show the disclaimer at each start-up.

– Remove the check mark and click OK not to show the disclaimer at each start-up.
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9.2 SplashScreen

Use the SplashScreen tool to create images to be shown on the LCP while the drive initializes.

Either create a splash screen from new, import an existing SplashScreen file, or import a picture.

9.2.1 SplashScreen Menus

9.2.1.1 New from Blank

Procedure

1. Select New from blank to open the editor with an empty project.
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Figure 209: Selecting New From Blank
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Figure 210: Empty Project in Editor

2. Use the different tools in the menu to create the drawing. Width increases/decreases brush line thickness, left mouse button is

for freehand line, right mouse button for straight lines.
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Figure 211: Drawing Tools

3. When finished, click Continue.
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4. In the dialog box, enter a file name and click Finish. Clicking Back returns to the editor, clicking Cancel cancels saving of the file.
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Figure 212: Dialog Box for Saving a SplashScreen Image

9.2.1.2 Select from Library

Procedure

1. Click Select from Library to open an already saved SplashScreen file (*.spla).

Select from Library is also used for editing already saved SplashScreen files.

9.2.1.3 Import

Use the import function for importing pictures to the SplashScreen.

The import function allows import of:

l jpeg.

l jpg.

l bmp.

l png.

l tif.

l gif.

l spla.

l splash.

At import, the picture resizes to fit the LCP. If the entire picture is not visible, set the threshold value of the imported image.
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Figure 213: SplashScreen with Original Threshold Value

e3
0b

t8
95

.1
0

Figure 214: SplashScreen Improved with Higher Threshold Values

The quality of the picture can be improved further by using the brush.
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Figure 215: SplashScreen Improved with the Brush Tool

When the picture is saved, the SplashScreen is added into the VLT® Software Customizer project along with a date and time stamp. It is

possible to edit and save more SplashScreen files, but only 1 appears in the project.
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Figure 216: SplashScreen and Preview Added to Project

Adding a SplashScreen to the project, changes the menu to offer the functions in Figure 217.
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Figure 217: Functions in the SplashScreen Menu

9.3 LanguageChanger

The LanguageChanger enables editing or creating a language by translating group names, subgroup names, help texts, and parameter

names.

When there is no file in the project, the menu is the same as in SplashScreen.
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Figure 218: Overview of the LanguageChanger Menu

9.3.1 LanguageChanger Functions

9.3.1.1 New from Blank

Selecting New from Blank opens the editor.

The editor contains tooltips about the Base Dictionary and the Base Dictionary Function.
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Figure 219: Tooltips in the Editor

Base Dictionary

Use the Base Dictionary for selecting which dictionary (LNG file) the LanguageChanger should load. For example, for translating into

Spanish, select Spanish in the Base Dictionary. The LanguageChanger then loads parameter names, help texts, and other texts in Spanish.

Base Dictionary Function

Use the Base Dictionary Function for defining if the LanguageChanger should prefill the translations with texts from the Base Dictionary. If

selecting Blanks fall back to base, the LanguageChanger leaves the translation field empty.
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Figure 220: Example of Base Dictionary set to English
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Figure 221: Example of Base Dictionary set to German

If selecting Prefill new dictionary from base, the LanguageChanger prefills the translation field with texts from the Base Dictionary.
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Figure 222: Example of Prefilled Translation Field with English Base
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Figure 223: Example of Prefilled Translation Field with German Base

After selecting Base Dictionary and Base Dictionary Function, and after pressing Start, the LanguageChanger opens.
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Figure 224: Overview of the LanguageChanger

NOTE: Language name on LCP comes from Base Dictionary. The name English is reserved for Danfoss. The name can be

changed, for example to English_Australia. This name is then shown in the LCP.
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Figure 225: Language Name on LCP
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Figure 226: Language Name Shown on the LCP

Once Language Name on LCP is set, it is possible to start modifying and translating.

NOTE: Not all parameters can be modified/translated. Parameters shown are the ones that can be modified or translated.

If clicking Cancel, a dialog appears.
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Figure 227: Cancel Dialog

Clicking OK closes the LanguageChanger without saving any changes.

Clicking Back goes back to the LanguageChanger editor.

When editing is done, press Continue and assign a name to the new dictionary file.
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Figure 228: LanguageChanger Project Name

The name is for the specific LanguageChanger project and is shown on the dashboard.
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Figure 229: LanguageChanger Dashboard with Project Name

9.3.1.2 Search Filter

To easily find parameter names or texts to be translated, click the Search filter button.
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Figure 230: Search Filter

Select to search in:

l Original texts and new dictionary,

l Original texts only, or

l New dictionary only.

For example, searching for motor power only shows the parameters that contain motor power in the name or in the help text.
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Figure 231: Search Result for Motor Power

9.3.1.3 Advanced Settings

Advanced settings contains tooltips for each possible setting and is helpful when creating a dictionary.
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Figure 232: Overview of the Advanced Settings
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Figure 233: Tooltip Example

9.3.1.4 Audit

Clicking Audit accepts the original text as it is and marks it completed without modifications or translations.

9.3.1.5 Markings

To visualize the progress of translation or creation of a dictionary, LanguageChanger shows different markups.

Text has not been modified or translated.

Text has been modified or translated.

Text has been accepted as is via the Audit function.

If Markings ignore audit is selected in the advanced settings, the marking only shows modified texts. All other texts are shown as
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9.4 InitialValues

Use InitialValues to create CSIV files. Without a CSIV file, all parameters are reset to default values during initialization of the drive. With a

CSIV file, parameter values are initialized with the values defined in the CSIV file.
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Figure 234: InitialValues Menu

9.4.1 InitialValues Functions

9.4.1.1 New from Blank

Procedure

1. Select New from Blank to open an empty project in the editor.
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Figure 235: Example of Empty Project

2. To add parameters, double-click in a parameter and change a value. For example, add German to the CSIV.
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Figure 236: Setting a Value for the CSIV File

3. Click OK to add the value to the CSIV file.
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Figure 237: Value Added to CSIV File

Alternatively, use filters to easily find parameters to add to the CSIV file. Search by the parameter name or ID.
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Figure 238: Example of Using Filters for Finding Parameters

To import a parameter available in the offline VLT® Motion Control Tool MCT 10 project, click Apply project values.
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Figure 239: Apply Project Values Button

9.4.1.2 Removing Parameters

Procedure

1. Select the parameter to be removed.

2. Click Reset selected parameter values to default.
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Figure 240: Removing a Parameter

NOTE: When resetting a parameter, other parameters may disappear from the CSIV file or change their values

due to dependencies.

9.4.1.3 Saving the CSIV File

Prerequisite: All values must be entered in the InitialValues editor before saving the CSIV file.

Procedure

1. Click Continue.

2. In the dialog box, enter a file name.
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3. Click Finish.

Clicking Back returns to the editor, clicking Cancel cancels saving of the CSIV file.

Ü When saving the CSIV file has completed, a preview of the file is shown in the project along with a date and time stamp.
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Figure 241: Preview of CSIV File in Project

9.4.1.4 Validation of Parameters During Import

Parameters are validated during import of a CSIV file. Incompatible parameters cannot be imported and are highlighted.

Incompatibilities can be caused by, for example, missing parameters or a CSIV file created for a different product series.
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Figure 242: Example of Incompatible Parameter

To copy the shown incompatibilities into Word or Notepad, click Copy incompatibilities.

To remove the incompatible parameters, click Remove incompatibilities.

It is possible to check the content of multiple CSIV files at import. Click Select other in the top left corner to open a Windows folder for

selecting other CSIV files.

9.5 Writing to Drive

9.5.1 Overview of the Writing to Drive Function

IMPORTANT: Writing to drive puts the drive in test monitor mode. This is a special mode where it is possible to write files

to flash the file system. It is important to turn off the drive.

Writing to drive writes files from the VLT® Software Customizer.

If a file is already in the drive, it is overwritten by the new file.

9.5.2 Preserve Original vs. Wipe Original

Write to drive writes all files. If a feature does not contain any files, select either to keep the original file in the drive, or to delete it (Wipe

Original). By default, Preserve Original is selected. To change this setting, select it from the menu of the given feature.

e3
0b

t9
52

.1
1

Figure 243: Menu for SplashScreen
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Changing from Preserve Original to Wipe Original issues a notification.

e3
0b

t9
53

.1
1

Figure 244: Notification when Changing Setting

After clicking OK, the new setting is shown in the project.
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Figure 245: New Setting Shown in Project

The settings are individual for each feature. If a feature has a file in the project, this setting is irrelevant and therefore grayed out.
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Figure 246: Example of Grayed-out Setting

NOTE: To make backup of files in the file system, use the Drive File System and the Drive File Manager.

9.5.3 Removing Files

Procedure

1. Select Remove from the given feature menu in the project.
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Figure 247: Removing a File

9.6 Testing in Simaltor

9.6.1 Overview of the Simulator

Use the simulator to test created files without being connected to a real drive and a real LCP. The simulator is an app that emulates LCP

behavior.
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Figure 248: Select Test in Simulator in the Top Menu

Each drive series and each software version have different simulators.

If the simulator is not available when selecting Test in Simulator, a message is shown.
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Figure 249: Warning Message - Simulator is not Installed

If the simulator is not available, contact a local Danfoss representative who can provide a zip file.

9.6.2 Installing the Simulator

Procedure

1. Save the zip file locally on a PC.

2. Open the Tools menu in VLT® Motion Control Tool MCT 10.

3. Select Update VLT Software Customizer support....
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Figure 250: Selecting the Update VLT Software Customizer Support
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Figure 251: LCP Simulator
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10 Tool Calling Interface (TCI)

10.1 Introduction

The TCI is an interface between the programming tool (TIA/Step 7) for the PLC and the VLT® Motion Control Tool MCT 10 and it supports

fieldbus communication over network boundaries.

The TCI is available in MCT 10 from version 4.20.

When installing the MCT 10, a program interface description (PID) file is created. This file acts as an interface between the TIA portal

and MCT 10. When MCT 10 is opened via the PLC, information about the drive and the parameter database is placed in a temporary

parameter (TPF) file.

Benefits

l Data is inside the programming file of the PLC.

l There is no risk of selecting the wrong MCT 10 project file.

l Exact match between the controller hardware configuration and MCT 10.

l The PLC calls MCT 10.

l Reduction of faults.

10.2 Installing the GSD/GSDML File

The GSD/GSDML file is required for the TCI interface to work. Danfoss provides the file.

Procedure

1. Unzip the file.

2. Open the TIA portal.

3. Click the Options menu.

4. Click Manage.

5. Select the file and install it.
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Figure 252: Installing the GSD/GSDML File

10.3 Creating a Project in TIA

Prerequisite: The following files must be installed before creating projects:

l TIA Portal tool version 14 or higher, or Step 7 version 5.6 or higher.

l VLT® Motion Control Tool MCT 10 version 4.20 or higher.

l GSD/GSDML file provided by Danfoss.

Procedure

1. Click Create project.

2. Expand the project in the project tree.

3. Click Devices & Networks.

4. Click Add new device.

5. Select the PLC.
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Figure 253: Add New Device

10.4 Use Cases

10.4.1 Doing the Initial Connection

Prerequisite: Add the PLC before the initial connection can be established.

Procedure

1. Click the Network icon at the top left corner of the right view.

2. Enter Danfoss in the search field.

Ü The GSD file appears.

3. Build the drive network in the PLC via drag and drop.
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Figure 254: Initial Connection

10.4.2 Configuring the TCI

Prerequisite: Program the PLC before starting the configuration.

Procedure

1. Right-click the drive icon and start the device tool.

Ü A dialog box shows for opening VLT® Motion Control Tool MCT 10.
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Figure 255: Start Device Tool
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Figure 256: Configuration

2. For online network: Select the network, for example TCI_Profinet.

Ü The tool scans drives which are mapped to the TCI interface. A drive appears if it is connected to the PLC.

3. For offline project: Identify all drives in offline mode.

This step is applicable for creating a project with drives that are not physically connected.
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Figure 257: Set Drive Manually

Ü Once the MCT 10 parameters are configured, and the tool is closed without saving the MCT 10 project, data goes to the TIA

portal and is saved as a TIA project.

When opening the drive from TIA, MCT 10 opens with the saved data and appears in MCT 10.
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11 SyncPos

11.1 SyncPos Handling

The VLT® 5000 and VLT® 5000 FLUX series have a SyncPos application option, which consists of a print card with a processor. For detailed

information, refer to Programmable SyncPos Motion Controller Operating Instructions.

VLT® Motion Control Tool MCT 10 can directly modify, read from, and write to SyncPos files. SyncPos files are stored within the MCT 10

files and do not require separate handling.

When a VLT® 5000 has a SyncPos option installed, the MCT 10 shows 2 icons after the drive has been selected:

l An All parameters folder icon.

l A separate SyncPos icon.

Parameter group 7-** Controllers is incorporated under All Parameters and applies to SyncPos.

NOTE: VLT® Motion Control Tool MCT 10 does not fully support the SyncPos application versions 1.xx and 2.xx. The

SyncPos folder is available due to the lack of functionality in these initial versions.

11.2 Programs and Configuration File

11.2.1 Introduction to the SyncPos Programs

The SyncPos program consists of 2 main parts:

l Configuration file (*.cnf ).

l Program files (*.m).

A configuration file consists of a series of SyncPos parameters which can be programmed. VLT® Motion Control Tool MCT 10 allows

importing, exporting, and setting up SyncPos configuration files.

11.2.2 Programs

Programs can be inserted in the VLT® Motion Control Tool MCT 10 Project folder. When a new SyncPos program is selected, an untitled

program is inserted in the SyncPos folder. The program can be edited, written, and exported as in the standalone SyncPos program. If a

SyncPos program exists, it can be imported into the MCT 10 project.

11.2.3 Viewing the Configuration File

Procedure

1. Select Configuration to view the drive configuration file in the right view of the screen.

2. To change the SyncPos settings, select the relevant drive in the right view to open a new editor (Cam Editor).

Refer to the Programmable SyncPos Motion Controller Operating Instructions for details on using the editor.

3. Change the settings.

4. Select Compile (in Settings in the main menu) or Exit Program (in File in the main menu).

5. When selecting Exit Program, select Read or Write.
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Ü The Confirm SyncPos write (or read) window pops up with 2 options for saving the SyncPos card.

6. Select the wanted option and select Yes or No.

When selecting Yes, the information is written to the drive.

NOTE: If Write to Drive is selected at the root of the drive, VLT® Motion Control Tool MCT 10 also writes the

SyncPos files to the SyncPos options. This can lead to an unattended stop of the SyncPos card.

11.2.4 Importing and Exporting a Configuration File

This procedure describes how to import a configuration file to a SyncPos card. Exporting a file is done in the same way, but select Export

instead of Import.

Procedure

1. Click the configuration file shown in the right view.
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Figure 258: Import Configuration File
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Figure 259: Import Configuration File

2. Select a configuration file for import from the computer directory.

3. Select the desired file and click Open to import the file to the Configuration folder.

11.2.5 Editing and Saving a Configuration File

Procedure

1. Select the configuration file to view and edit.

Ü The configuration editor opens.

2. Make the required changes to the configuration file.

3. Close the SyncPos application.

Ü The SyncPos Application Closed dialog appears.
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Figure 260: SyncPos Application Closed

4. Select

– Read to save changes to VLT® Motion Control Tool MCT 10.

– Write to save changes to the drive.
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Reading or writing can take some time.

11.2.6 Importing Program Files

Procedure

1. Click a program shown in the right view.
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Figure 261: Import Program to SyncPos Card

2. Browse the computer to find the program to import.
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Figure 262: Browse

3. Select the wanted program.
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4. Click Open to import the program in the Programs folder.

Ü The import is now complete.

11.2.7 Setting a Program to Auto Start

If more than 1 program is stored in the Programs folder, it is possible to set 1 of them to start automatically when the device is turned on.

Procedure

1. Select the start-up program in the right view of the screen.

2. Right-click and select Set As Auto Start.
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Figure 263: Auto Start

Ü The program selected is then indicated with Yes in the Auto Start column.

11.2.8 Editing Source Code

For detailed information about the source code, refer to Programmable SyncPos Motion Controller Operating Instructions. To view or edit

the source code, follow this procedure:

Procedure

1. Double-click Program in the right view.
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Figure 264: View/Edit Source Code

A range of editing operations are possible, described in detail in the Programmable SyncPos Motion Controller Operating

Instructions.

11.2.9 Saving and Exiting Program

When editing a configuration file, a SyncPos Application Closed dialog box pops up. Select Read or Write according to the instructions in

the box.

NOTE: If there are programs in the SyncPos card, they are deleted without further warning.
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Figure 265: Confirm SyncPos Write

Procedure

1. Select File⇒Save in the menu bar to save the changes to the program file opened from the VLT® Motion Control Tool MCT 10

project.

2. Select File⇒Exit program in the menu bar to exit SyncPos.
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Figure 266: Exit Program

11.3 SyncPos Read from Drive

Parameters and SyncPos files can be read from a drive to a project.

Procedure

1. Right-click the root drive.

2. Select Read from Drive.

214 | Danfoss A/S © 2025.07                                                                                                                                                                     AQ283728700891en-001201 / 130R0466

Operating Guide | VLT® Motion Control Tool MCT 10                                                                                                                                                    SyncPos



Operating Guide | VLT® Motion Control Tool MCT 10                                                                                                                                                    SyncPos

e3
0b

t5
10

.1
2

Figure 267: SyncPos Read From Drive

NOTE: Files in the project can be permanently lost as files of the same name are overwritten:
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Figure 268: Files Overwritten

3. Select Yes to start reading and saving the configuration files and programs from the drive to the project.

11.4 SyncPos Write to Drive

All parameters and SyncPos files can be written to a drive.

Procedure

1. Right-click the root drive.

2. Select Write to Drive.
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Figure 269: Write to Drive

NOTE: Use this feature with caution. If incorrectly used, files on the drive can be permanently lost. The

following warning appears, explaining that files of the same name are overwritten:
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Figure 270: Warning Files Overwritten

3. Select the required settings.

4. Select Yes to start writing.

Ü For the preceding settings, the existing programs are deleted. Then the SyncPos program source files are written to the drive.

Once the write is complete, check the contents of the Network folder to confirm that the write to drive was successful.
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12 Troubleshooting

12.1 Save Error Dialog

When an error dialog appears on the screen, VLT® Motion Control Tool MCT 10 can save the error to a text file to record the error message

for later reference, for example to obtain help from support. Within the error dialog window, select Save As to record the error message as

a text file with free choice of file name and location.

For example, when scanning the network for drives, an error dialog appears, showing the drives which are not detected.
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2

Figure 271: Drives not Detected

To store the error log, select Save As.
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Figure 272: Store Error Log

12.2 Common Problems and Solutions

12.2.1 Changes are not Saved to PC

Check that changes made in the Network folder have been copied to the Project folder and then saved to a hard disk. Changes made in

the Network folder are implemented in the field device only and are not automatically saved to a PC.

12.2.2 Error Message While Installing VLT® Motion Control Tool MCT 10

A message such as MCT 10 SET-UP SOFTWARE ERROR OPENING FC DRIVER may occur, if there is another PC program installed using

the same COM port of the PC. Such a program could be a PLC programming tool, palm pilot driver, or cellular phone driver. Investigate

whether other programs use the same COM port. If so, ensure that the other PC tool does not lock or reserve the COM port.

12.2.3 Error Message Communication Failed

Sporadic communication errors

This type of communication error typically occurs when cables are inadequately shielded, in which case EMC noise can affect the

communication. Check that the cables are installed according to the guidelines in the operating guide for the drive.

The communication error is permanent

This type of communication error is typically due to an error in network configuration. Check that the network configuration is in

accordance with the drive operating guide.
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Communication failed

The Communication failed error message appears in the status bar.
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Figure 273: Error Message: Communication Failed

12.2.4 Communication Errors

If an erroneous/illegal action has been attempted, an error highlight appears in the status bar at the bottom of the VLT® Motion Control

Tool MCT 10 window.

When a communication error occurs, the status bar at the bottom of the MCT 10 window is highlighted and shows a Communication

failed error message.
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Figure 274: Error Message: Communication Failed

When no communication error has occurred, the same window appears as:
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Figure 275: Communication OK

Communication errors typically occur due to inadequate shielding of cables, meaning that the cable is not installed in accordance with

the installation instructions.
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12.2.5 Help

Select Help⇒Help in the main menu. A help file opens and shows the VLT® Motion Control Tool MCT 10 guide in .pdf format. Acrobat

Reader software is required to open the guide. It can be downloaded free of charge at www.adobe.com.

12.3 Safe Plug-in Troubleshooting

12.3.1 Troubleshooting Communication Errors

During commission, the communication between VLT® Motion Control Tool MCT 10 and the drive can fail. Failed communication issues

an error message.

Confirm the status of the communication devices and the drive and the status of the drive to guarantee proper communication.

12.3.2 Troubleshooting CRC Errors

CRC errors can occur during the write-to-drive procedure. If a CRC error occurs, try to write to the drive again.

If the CRC errors persist, verify the integrity of the devices and communication.

12.3.3 Warnings and Alarms

NOTE: The errors are listed numerically.
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Table 27: LED Indications, Errors 1–67

Error number Description LED indicators

LED1 LED2 LED4

Internal failure Reason Action

1 Diagnostic in
progress

Green constant

67 Int Fail tolerance
error exceeded:
Reaction STO

l Check that
data for
feedback
(PPR, type
of feedback,
and gear
ratio) is
entered
correctly.

l Direction of
feedback is
wrong.

l Due to use
of feedback
filter the
dynamic of
the system
does not
match with
dynamic of
feedback
filter
(parameter
42-15

Feedback

Filter).
System is
ramping too
fast.

l Feedback
signals are
not received
at all.

l No proper
shielding
of feedback
cables.

l Make a
recustomizati
on with
correct data if
needed.

l Set
parameter
42-12

Encoder

Direction to
the opposite
value.

l Decrease the
ramping time
on the drive.

l Try to run the
system at,
for example,
60 RPM. If
error 99, Int
Fail Feedback
error occurs,
this is the
reason.

l Improve
shielding
of feedback
cables and
motor cables.

Status of LED 1 and LED2 depends
on safety sub-function state as-
signed to DI1 and DI2.

Red constant
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Table 28: LED Indications, Errors 68–69

Error number Description LED indicators

LED1 LED2 LED4

Internal failure Reason Action

68 Int fail Speed
limit SS1a Ramp:
Reaction STO

l The value
of Delta V
is too small.
For closed-
loop system,
it must often
be larger
than the
recommende
d value.

l Due to use
of feedback
filter the
dynamic of
the system
does not
match with
dynamic of
feedback
filter
(parameter
42-15

Feedback

Filter).

l Load change
takes place
during
ramping.

l If running in
closed loop,
try to adjust
PID setting
and if needed
increase SS1
ramping
time.

l Try to
increase
parameter
42-15

Feedback

Filter, but this
might cause
error 67, Int
Fail tolerance
error
exceeded:
Reaction STO
to occur.

l Otherwise
increase
parameter
42-45 Delta

V.

Red constant

69 Int fail Speed
limit SS1b Ramp:
Reaction STO

See 68. See 68.

Status of LED 1 and LED2 depends
on safety sub-function state as-
signed to DI1 and DI2.

Red constant
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Table 29: LED Indications, Errors 70–71

Error number Description LED indicators

LED1 LED2 LED4

Internal failure Reason Action

70 Int fail speed
limit SLSa: Reac-
tion STO

Happens during
ramping to SLS
limit, see 68.

Happens during
speed below SLS
limit:

l If speed is
above cut-
off speed at
activation
point and
parameter
42-53 Start

Ramp is set
to [0] No, this
error occurs.

l Noise on the
feedback
signal (incl.
quantization
noise) is
larger than
expected.

l Load change
takes place,
do as in
above point.

l Change
parameter
42-53 Start

Rampto [1]

Yes and set
parameter
42-54 Ramp

Down

Time accordi
ngly.

l Increase
parameter
42-50 Cut

Off Speed

or decrease
parameter
42-51 Speed

Limit to
get a larger
tolerance.

Status of LED 1
and LED 2 de-
pends on safety
sub-function
state assigned to
DI1 and DI2.

Red constant

71 Int fail speed
limit SLSb: Reac-
tion STO

See 70. See 70. Red constant
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Table 30: LED Indications, Errors 72–73

Error number Description LED indicators

LED1 LED2 LED4

Internal failure Reason Action

72 Internal failure
MCB 150/151

l First, power
cycle the
drive or
restart the
safety option
via parameter
42-90 Restart

Safe Option.
Second, try
to make
a general
reset of the
safety option
with the
Administratio
n button
(safety option
goes back to
blank initial
state).

l If the
problem
persists,
contact
Danfoss.

Red constant

73 Internal failure
MCB 150/151

l First, power
cycle the
drive or
restart the
safety option
via parameter
42-90 Restart

Safe Option.

l If the
problem
persists,
contact
Danfoss.

Red constant
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Table 31: LED Indications, Errors 74–75

Error number Description LED indicators

LED1 LED2 LED4

Internal failure Reason Action

74 Internal failure
MCB 150/151

l First, power
cycle the
drive or
restart the
safety option
via parameter
42-90 Restart

Safe Option.

l If the
problem
persists,
contact
Danfoss.

Red constant

75 Int Fail DI2 in
PUST: Reaction
STO

l Safety input
connected
to DI2 has
illegal signal
level.

l Sensor is
broken.

l Check
that the
configuration
of DI2
parameter
42-21 Type is
set correctly
or that the
connected
sensor is
installed
according to
specification.

l Extend
discrepancy
time on the
safe input tab
in the MCT 10
Safe Plug-in
via parameter
14-22

Operation

Mode.

Status of LED 1 and LED 2 depends
on safety sub-function state as-
signed to DI1 and DI2.

Red constant
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Table 32: LED Indications, Errors 76–77

Error number Description LED indicators

LED1 LED2 LED4

Internal failure Reason Action

76 Int Fail DI1 in
PUST: Reaction
STO

l Safety input
connected
to DI1 has
illegal signal
level.

l Sensor is
broken.

l Check
that the
configuration
of DI1
parameter
42-21 Type,
sub-index
[0], is set
correctly
or that the
connected
sensor is
installed
according to
specification.

l Extend
discrepancy
time on the
safe input tab
in the MCT 10
Safe Plug-in
via parameter
14-22

Operation

Mode.

Red constant

77 Int Fail failsafe
data CRC mis-
match: Reaction
STO

The CRC of the
safety option
does not match
the stored CRC
value on the
drive.

Configure the
safety option
with MCT 10 Safe
Plug-in or by CRC
select/LCP copy.

Status of LED 1 and LED 2 depends
on safety sub-function state as-
signed to DI1 and DI2.

Red constant
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Table 33: LED Indications, Errors 78–83

Error number Description LED indicators

LED1 LED2 LED4

Internal failure Reason Action

78 Internal failure
safety option

l First, power
cycle the
drive or
restart the
safety option
via parameter
42-90 Restart

Safe Option.

l If the
problem
persists,
contact
Danfoss.

Red constant

79 Internal failure
safety option

Contact Danfoss. Red constant

80 Internal failure
safety option

Contact Danfoss. Red constant

81 Internal failure
safety option

l First, power
cycle the
drive.

l If the
problem
persists,
contact
Danfoss.

Red constant

82 Internal failure
safety option

l First, power
cycle the
drive.

l If the
problem
persists,
contact
Danfoss.

Red constant

83 Internal failure
safety option

l First, power
cycle the
drive.

l If the
problem
persists,
contact
Danfoss.

Status of LED 1 and LED 2 depends
on safety sub-function state as-
signed to DI1 and DI2.

Red constant
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Table 34: LED Indications, Errors 84–88

Error number Description LED indicators

LED1 LED2 LED4

Internal failure Reason Action

84 Internal failure
safety option

l First, power
cycle the
drive.

l If the
problem
persists,
contact
Danfoss.

Red constant

85 Internal failure
safety option

l First, power
cycle the
drive.

l If the
problem
persists,
contact
Danfoss.

Red constant

86 Internal failure
safety option

l First, power
cycle the
drive.

l If the
problem
persists,
contact
Danfoss.

Red constant

87 Internal failure
safety option

l First, power
cycle the
drive.

l If the
problem
persists,
contact
Danfoss.

Red constant

88 Internal failure
safety option

l First, power
cycle the
drive.

l If the
problem
persists,
contact
Danfoss.

Status of LED 1 and LED 2 depends
on safety sub-function state as-
signed to DI1 and DI2.

Red constant
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Table 35: LED Indications, Errors 89–92

Error number Description LED indicators

LED1 LED2 LED4

Internal failure Reason Action

89 Internal failure
safety option

l Perform
a general
reset of the
safety option
with the
Administratio
nbutton.

l If the
problem
persists,
contact
Danfoss.

Red constant

90 Internal failure
safety option

l Perform
a general
reset of the
safety option
with the
Administratio
nbutton.

l If the
problem
persists,
contact
Danfoss.

Red constant

91 Internal failure
safety option

l Perform
a general
reset of the
safety option
with the
Administratio
nbutton.

l If the
problem
persists,
contact
Danfoss.

Status of LED 1 and LED 2 depends
on safety sub-function state as-
signed to DI1 and DI2.

Red constant
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Table 35: LED Indications, Errors 89–92 - (continued)

Error number Description LED indicators

LED1 LED2 LED4

Internal failure Reason Action

92 Internal failure
safety option

l First, power
cycle the
drive.

l If the
problem
persists,
contact
Danfoss.

Red constant
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Table 36: LED Indications, Errors 93–97

Error number Description LED indicators

LED1 LED2 LED4

Internal failure Reason Action

93 Internal failure
safety option

l First, power
cycle the
drive.

l If the
problem
persists,
contact
Danfoss.

Red constant

94 Internal failure
safety option

l First, power
cycle the
drive.

l If the
problem
persists,
contact
Danfoss.

Red constant

95 Internal failure
safety option

l First, power
cycle the
drive.

l If the
problem
persists,
contact
Danfoss.

Red constant

96 Internal failure
safety option

l First, power
cycle the
drive.

l If the
problem
persists,
contact
Danfoss.

Red constant

97 Internal failure
safety option

Contact Danfoss.

Status of LED 1 and LED 2 depends
on safety sub-function state as-
signed to DI1 and DI2.

Red constant
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Table 37: LED Indications, Errors 98–113

Error number Description LED indicators

LED1 LED2 LED4

Internal failure Reason Action

98 Int fail invalid
customer file ver-
sion

Version of cus-
tomization file
of safety option
stored in EEP-
ROM does not
match the cus-
tomization file
supported by the
SW version of
safety option.

Do a new config-
uration with VLT®
Motion Control
ToolMCT 10 Safe
Plug-in, which
supports the SW
version of safety
option.

99 Int Fail Feedback
error

The connected
feedback source
does not give
any signal.

Check that the
connection is
done according
to the specifi-
cation or if the
feedback source
is broken.

Red

102 Int Fail Speed
Limit SMS: Reac-
tion STO

l Speed is
above cut-off
speed.

l Noise on the
feedback
signal (incl.
quantization
noise) is
larger than
expected.

Check the value
of parameter
42-71 Cut Off

Speed.

Status of LED 1 and LED 2 depends
on safety sub-function state as-
signed to DI1 and DI2.

Red constant

113 Ext Fail DI1: Reac-
tion STO

l Safety input
connected
to DI1 has
illegal signal
level.

l Sensor is
broken.

l Check that
configuration
of DI1
parameter
42-21 Type is
set correctly
or the
connected
sensor is
installed
according
to the
specification.

Red constant Status depends
on safety sub-
function state as-
signed to DI2.

Red flashing, cy-
cle (on 500 ms,
off 500 ms)
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Table 38: LED Indications, Errors 114–116

Error number Description LED indicators

LED1 LED2 LED4

Internal failure Reason Action

114 Ext Fail DI2: Reac-
tion STO

l Safety input
connected
to DI2 has
illegal signal
level.

l Sensor is
broken.

l Check that
configuration
of DI2
parameter
42-21 Type is
set correctly
or the
connected
sensor is
installed
according
to the
specification.

l Extend
discrepancy
time on safe
input tab
in MCT 10
Safe Plug-in
parameter
14-22

Operation

Mode.

Status depends
on safety sub-
function state as-
signed to DI1.

Red constant. Red flashing, cy-
cle (on 500 ms,
off 500 ms)

115 Ext Fail Prec
Thresh Timer
Elapsed: Reaction
STO

The drive has
been running be-
low 120 RPM for
more than the
time entered in
parameter 42-18

Zero Speed Timer

with safe func-
tion SLS active.

Increase speed to
above 120 RPM.

Red flashing, cy-
cle (on 500 ms,
off 500 ms)

116 Ext Fail SF activa-
tion Speed Sus-
pension: Reac-
tion STO

The drive has
been running
below 120 RPM
for more that 1
year and a safety
sub-function
that needs speed
feedback is acti-
vated.

Increase speed to
above 120 RPM.

Status of LED 1 and LED 2 depends
on safety sub-function state as-
signed to DI1 and DI2.

Red flashing, cy-
cle (on 500 ms,
off 500 ms)
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Table 39: LED Indications, Errors 134–242

Error number Description LED indicators

LED1 LED2 LED4

Internal failure Reason Action

134 Int fail speed
limit SLSa: Reac-
tion SS1a

See 70. See 70. Red constant

135 Int fail speed
limit SLSb: Reac-
tion SS1a

See 70. See 70.

Status of LED 1 and LED 2 depends
on safety sub-function state as-
signed to DI1 and DI2.

Red constant

177 Ext Fail DI1: Reac-
tion SS1a

See 113. See 113. Red constant. Status depends
on safety sub-
function state as-
signed to DI2.

Red flashing, cy-
cle (on 500 ms,
off 500 ms)

178 Ext Fail DI2: Reac-
tion SS1a

See 114. See 114. Status depends
on safety sub-
function state as-
signed to DI1.

Red constant. Red flashing, cy-
cle (on 500 ms,
off 500 ms)

179 Ext Fail Prec
Thresh Timer
Elapsed: Reaction
SS1a

See 115. See 115. Red flashing, cy-
cle (on 500 ms,
off 500 ms)

180 Ext Fail SF activa-
tion Speed Sus-
pension: Reac-
tion SS1a

See 116. See 116. Red flashing, cy-
cle (on 500 ms,
off 500 ms)

198 Int fail speed
limit SLSa: Reac-
tion SS1b

See 70. See 70. Red constant

199 Int fail speed
limit SLSb: Reac-
tion SS1b

See 70. See 70.

Status of LED 1 and LED 2 depends
on safety sub-function state as-
signed to DI1 and DI2.

Red constant

241 Ext Fail DI1: Reac-
tion SS1b

See 113. See 113. Red constant. Status depends
on safety sub-
function state as-
signed to DI2.

Red flashing, cy-
cle (on 500 ms,
off 500 ms)

242 Ext Fail DI2: Reac-
tion SS1b

See 114. See 114. Status depends
on safety sub-
function state as-
signed to DI1.

Red constant. Red flashing, cy-
cle (on 500 ms,
off 500 ms)
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Table 40: LED Indications, Errors 243–252

Error number Description LED indicators

LED1 LED2 LED4

Internal failure Reason Action

243 Ext Fail Prec
Thresh Timer
Elapsed: Reaction
SS1b

See 115. See 115. Red flashing, cy-
cle (on 500 ms,
off 500 ms)

244 Ext Fail SF activa-
tion Speed Sus-
pension: Reac-
tion SS1b

See 116. See 116. Red flashing, cy-
cle (on 500 ms,
off 500 ms)

252 Internal failure
safety option

Power cycle the
drive. If the prob-
lem persists, con-
tact Danfoss.

12.3.4 Safety Option Warning

A warning message notifies that an issue exists on the safety option. It is not handled as an internal or external failure. These messages

are defined to indicate that a manual user action is required.

NOTE: At any possible failure or warning indicated from the safety option, the LCP shows warning, !Safe Option Failure

[W252] at the least.

12.3.5 Safety Option Reset Message

For some messages, the safety option requires an acknowledgment of an ongoing action or failure on the safety option. The safety

option uses Safe Option RESET as a Restart and Failure Acknowledgement.
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Table 41: LCP Reset Messages

LCP message Description

e3
0b

d1
26

.1
1

SO Reset required!

!1(1)Status
0 RPM None 0.00KW

!Safe Stop [W68]
Off Remote SO Req.REST

In the following cases, the safety option requests a restart and fail-
ure acknowledgment signal:

l The safety option is in safety subfunction pending-state
(remark: Occurs only if the reset behavior is set/configured to
Manual).

l After a power cycle with a safety subfunction.

l In PUST (power up self-test), if an external failure occurred
before the power cycle.

l When an external failure occurred.

l When customization was aborted or completed.

l At the reception of a general reset (required after blank initial
state or in the customization state).

e3
0b

d1
27

.1
1

SO in Self-test

!1(1)Status
0 RPM None 0.00KW

!Safe Stop [W68]
Off Remote SO Req.REST

The safety option indicates that it is in PUST State (power up self-
test).

l Ensure that no safe function is active after a power cycle.

e3
0b

d1
27

.1
1

SO in Self-test

!1(1)Status
0 RPM None 0.00KW

!Safe Stop [W68]
Off Remote SO Req.REST

A safety subfunction is pending at the start-up, if the drive was
powered down while a safety function was active. It is also pend-
ing when the drive was powered down while the safety option
had detected a failure during an active safety subfunction.

e3
0b

d1
29

.1
1

  SafeOpt. initialised

!1(1)Status
0 RPM None 0.00KW

!Safe Stop [W68]
Off Remote SO Req.REST

The safety option requests a Restart and Failure Acknowledge sig-
nal. This signal is always required after a PUST, and when a safety
subfunction gets released and is configured to be confirmed that
the motor is able to run.

e3
0b

d1
30

.1
1

  SO General Reset

!1(1)Status
0 RPM None 0.00KW

!Safe Stop [W68]
Off Remote SO Req.REST

Occurs only if a general reset is performed from MCT 10. It is an in-
dication to the user. The safety option is set to blank initial state
and safe parameters are set to default.

e3
0b

d1
31

.1
1

SO Suspend-SpeedMon

!1(1)Status
0 RPM None 0.00KW

!Safe Stop [W68]
Off Remote SO Req.REST

The zero speed timer contains the remaining time until the fail
prec thresh timer elapsed after the monitoring time expires. The
safety option signals Warning.

e3
0b

d1
32

.1
1Status

SO Warning PUST

!1(1)

!Safe Stop [W68]
Off Remote SO Req.REST

0 RPM None 0.00KW

PUST warning has occurred. Warning cause: Expiry of PUST timer.
Memory test required, perform power cycle.
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Table 41: LCP Reset Messages - (continued)

LCP message Description
e3

0b
d1

33
.1

1Status

SO Warning DI1

!1(1)
0 RPM None 0.00KW

!Safe Stop [W68]
Off Remote SO Req.REST

DI1 offline warning has occurred. Warning cause: Expiry of offline
timer for DI1.

e3
0b

d1
34

.1
1

SO Warning DI2

!1(1)Status
0 RPM None 0.00KW

!Safe Stop [W68]
Off Remote SO Req.REST

DI2 offline warning has occurred. Warning cause: Expiry of offline
timer for DI2.

e3
0b

d1
31

.1
1

SO Suspend-SpeedMon

!1(1)Status
0 RPM None 0.00KW

!Safe Stop [W68]
Off Remote SO Req.REST

A speed monitoring suspension warning has occurred. Warning
cause: Suspension of speed monitoring for a certain duration.
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